ArcUser
The Magazine for Esri Software Users

GIS Systems Lead Response to COVID-19 34

Map It. Believe It. See It. 60

Getting Data Ready for Next Generation 9-1-1 12
Precision Powered.
Reality Captured.
Confidence Delivered.

Geospatial.trimble.com/esri

© 2020, Trimble Inc. All rights reserved. GEO-174 (02/20)
Contents

Focus

10  An Easier Way to Transform Parcel Data
12  Getting Data Ready for Next Generation 9-1-1
16  Addressing Recycling Challenges
20  Connecting the Built and Natural Environments with 3D GIS

Special Section

34  GIS Systems Lead Response to COVID-19
39  Esri’s DRP Lends Support to Worldwide Efforts against Pandemic
40  Reallocating Resources for COVID-19 Response

End Notes

68  Promoting Plant Species Conservation

On the Cover

This 3D map visualizes International Civil Aviation Organization (ICAO) data on daily flights showing COVID-19 cases.
GIS technology has come to the fore in the response to the coronavirus disease 2019 (COVID-19) pandemic. Organizations around the world have created ArcGIS Dashboards, which have become a critical means for providing access to authoritative information and have been viewed billions of times. The maps in these dashboards, showing the global distribution and the magnitude of the outbreak, make it easy to immediately grasp the scope and seriousness of the pandemic.

The effectiveness of GIS technology was demonstrated not only by organizations that were existing users but by those that had little or no experience with GIS. These GIS newcomers got software and support from Esri, which freely offered help to any organization battling COVID-19.

GIS technology has played an unprecedented role in the response to the pandemic because it is supported by a geospatial infrastructure that spans the globe. Instead of just the GIS of individual cities, states, or nations, it has become a system of systems.

This larger vision for GIS technology combines and organizes data of all kinds in a geographic framework. That data, supplied as web services, is immediately accessible via the Esri Geospatial Cloud and available for visualization, analysis, and modeling.

This is GIS at scale.

The textbook definition of a geographic information system is that it is composed of software, hardware, data, and people. The people in GIS are critical to its success. The technology is powerful, but leadership is necessary for GIS to make a difference in outcomes.

GIS professionals have been playing a critical role in enabling their organizations’ efforts during the pandemic. Their work is answering questions such as, Where and who are the people who are sick? Where and who are the people who are most at risk? Where should testing sites be located? The answers to these and other questions make more informed decisions and policies possible.

As GIS people have stepped up their game in these challenging circumstances, they are making a real difference in COVID-19 response, mitigation, and recovery efforts.

Jack Dangermond, Esri president, applauds these efforts. “I think this is such a testimony to the ability for our community to really come together and respond. Frankly, I am personally overwhelmed by the goodness that our community is providing.”

Monica Pratt
ArcUser Editor
Departments

Software and Data

6 Briefly Noted
7 ArcGIS Earth Enables Visualization, Interactive Analysis, and Sharing
8 Better Together: ArcGIS Pro and Jupyter Notebook
9 ArcGIS Notebooks for ArcGIS Online Beta

Manager’s Corner

24 The Role of GIS in Today’s Planning Department

Developer’s Section

26 Use Parts of the New Map Viewer to Build Your Own Better Apps
30 DevSummit Showcases Powerful Tools for Visualization and Data Science
32 Tips for Configuring Apps with Mobile in Mind

Hands On

42 Mapping SSURGO Soils with ArcGIS Pro
49 Too Many Acronyms but Lots of Value
50 Finish Your Map with Layout Text
53 Help Yourself and Others with Effective Field Naming
56 Learn to Use ArcGIS QuickCapture
58 Add Hand-Drawn Charm to Your Maps

Bookshelf

59 Python Scripting for ArcGIS Pro
59 Women and GIS: Stars of Spatial Science, Volume 2

Faces of GIS

60 Map It. Believe It. See It.

Education

64 Teach Demographics with Web GIS
Briefly Noted

→ ArcGIS Dashboards Beta

All ArcGIS Online users are invited to try a public beta of the next version of ArcGIS Dashboards (formerly Operations Dashboard for ArcGIS). Built on the ArcGIS API 4.x for JavaScript, ArcGIS Dashboards has been rearchitected so that dashboard authors can take advantage of enhancements that have been introduced across the ArcGIS platform.

Advances in overall map performance are part of an improved user experience. Better summary statistics for percentile and count and support for HEX, RGB, and HSL formats for color input provide more flexibility in data visualization.

ArcGIS Dashboards will fully leverage map authoring customizations using ArcGIS Arcade, a portable, lightweight, and secure expression language written for use in the ArcGIS platform. Arcade can be used to perform mathematical calculations, manipulate text, and evaluate logical statements. ArcGIS Dashboards exposes an interface for users to directly compose Arcade expressions for list and indicator elements that customize how data points are rendered.

ArcGIS Dashboards can be accessed by clicking the ArcGIS Dashboards icon labeled BETA in the ArcGIS Online app launcher. After ArcGIS Dashboards moves out of beta, it will be available in the subsequent version of ArcGIS Enterprise. Go to the ArcGIS Dashboards Beta GeoNet community for help and FAQ documentation on the beta version.

→ Saint Louis University and Esri to Advance Geospatial Innovation

Saint Louis University (SLU) and Esri will work on emergency management, health care, public safety, and economic development projects.

SLU, well-known for its commitment to geospatial research and application development, recently founded the Geospatial Institute (GeoSLU). The institute will encourage students and staff to explore ways that GIS technology can provide insight into climate change, access to food and clean water, economic stability, and other issues.

SLU and Esri are both affiliated with the National Geospatial-Intelligence Agency (NGA), the nation's primary resource for geospatial intelligence (GEOINT) for the defense and intelligence communities. Esri has collaborated with NGA for the last 30 years to broaden the scope and application of GEOINT nationwide. SLU signed a collaborative research and development agreement (CRADA) with NGA last year to share technical capabilities and research efforts to drive innovation in the geospatial field.
ArcGIS Earth Enables Visualization, Interactive Analysis, and Sharing

ArcGIS Earth provides an immersive 3D experience for exploring, fusing, visualizing, and sharing data. It is easy to use and can be deployed behind firewalls. Recent releases support KML editing, mobile, and using large data files disconnected from the internet.

Available on the Windows desktop and Android and iOS mobile devices, ArcGIS Earth is a free, interactive globe that is part of the Esri Geospatial Cloud and is fully integrated with the ArcGIS platform.

ArcGIS Earth lets anyone explore the world and display data on the globe, tilt and rotate the view, measure distances and areas, add annotations, and perform interactive analysis using line-of-sight, viewshed, and elevation tools. Use items from ArcGIS Online, ArcGIS Enterprise, local data, and web services. Display data by adding it through the interface, dragging and dropping, or using a QR Code. Workspaces are automatically saved. ArcGIS Earth supports multiple coordinate referencing systems including the Military Grid Reference System (MGRS).

Keyhole Markup Language (KML) is a file type for displaying and working with information in simple geographic context that is popular with government agencies that still use legacy systems that generate these XML-based formats. ArcGIS Earth supports file-based workflows and the use of the legacy KML file type, including editing feature geometry, network links, graphic styles, file structure, and error handling, as well as saving the results as a new KMZ file. Users can add, edit, and save KML features such as screen overlays, ground overlays, and network links directly in ArcGIS Earth.

KML geometry editing capabilities include editing vertices, altitude, and extrusion. Layer properties for pop-up info, view, size, color, and transparency can also be edited. Military symbology is supported.

KML editing also includes the ability to reorder the file structure; add new graphics; remove contents; and cut, copy, and paste text. Edited files can be copied and shared.

Mobile scene packages (MSPKs) provide a method for sharing and taking 3D scenes and content offline. This new data type allows for clip, zip, and ship workflows. Create MSPKs in ArcGIS Pro or in apps built using ArcGIS Runtime SDKs. They can be shared across your organizations via ArcGIS Online or and ArcGIS Enterprise 10.7 or higher. MSPKs can be accessed in desktop or mobile versions of ArcGIS Earth.

The addition of this format expands the data types that can be used directly in ArcGIS Earth. This offline workflow has functionality that has been requested by government agencies. ArcGIS Earth is simple to use so knowledge workers and analysts who are not GIS specialists can fuse data and perform exploratory analysis in 3D, even in a disconnected environment.

→ ArcGIS Earth can use KML data and adjust the view, size, color, and transparency when symbolizing it.
Better Together: ArcGIS Pro and Jupyter Notebook

By Lipika Gimmler and Shannon Kalisky

ArcGIS Notebooks lets you easily switch between the intuitive GUI of ArcGIS Pro and the scripting and annotated interface of Jupyter Notebook, providing a complete data science workstation.

In ArcGIS Pro 2.5, you can create, edit, and save a Jupyter Notebook as part of your ArcGIS Pro project with ArcGIS Notebooks, Esri’s Jupyter Notebook environment. You can create a notebook as part of an ArcGIS Pro project and edit the notebook using the Jupyter interface that now comes included in all editions of ArcGIS Pro 2.5. Access ArcGIS Notebooks in ArcGIS Pro simply by installing or upgrading to ArcGIS Pro 2.5 (Basic, Standard or Advanced license levels). No additional cost, installer, license, or app is required.

The notebooks you create in ArcGIS Pro will leverage the ArcGIS Pro Python environment, which can be customized through the Python Package Manager, the Python Command Prompt, or through Anaconda.

Why Use ArcGIS Notebooks?
ArcGIS Notebooks provides many benefits. It streamlines processes; makes collaboration easier; give you more convenient access to open-source Python; and lets you work seamlessly between ArcGIS Notebooks and the ArcGIS Pro UI, automate work; and build reproducible research.

Rather than having part of your analysis in ArcGIS Pro and another part in a separate Jupyter environment, ArcGIS Notebooks keeps a connection between ArcGIS Pro and Jupyter Notebook. Because you can store related notebooks within ArcGIS Pro projects, you always have access to any notebook you need.

ArcGIS Notebooks in ArcGIS Pro gives GIS professionals a place to run Python notebooks without leaving the familiar ArcGIS Pro environment.
GIS professionals a place to run Python notebooks without leaving the familiar ArcGIS Pro environment. You can easily import notebooks (.ipynb files) across your organization, while also having a built-in environment to create your own notebooks. Any notebook created within ArcGIS Pro can be run in an open-source Jupyter environment or in ArcGIS Notebooks hosted on ArcGIS Enterprise or ArcGIS Online. You just need to make sure that the libraries used in the notebook are available in these other environments.

Python open-source integration has long been a feature of ArcGIS Pro, but with built-in Python notebooks, you can more readily explore all that open-source integration has to offer. Create pandas dataframes, data visualizations with libraries like Matplotlib, or read in large datasets using Dask. The interactive notebook interface gives you instant feedback on code execution without requiring debugging of the entire script, making it ideal for iterative analysis and data discovery.

Switch seamlessly between ArcGIS Notebooks and the ArcGIS Pro UI. You can use ArcPy to call layers from an ArcGIS Pro project from within its notebook. Results from the notebook can be added to the ArcGIS Pro map view. In addition to moving data and results back and forth, the notebook pane can be docked within the ArcGIS Pro interface, so it can be displayed at full screen or viewed alongside maps, charts, and data. This centralizes the analytics pipeline in one place.

Use ArcGIS Notebooks to automate repetitive tasks and document the workflow of those tasks. Notebooks can be used to automate analysis and data engineering activities. When connected to ArcGIS Online or ArcGIS Enterprise, it can be used to automate content management and administration for Web GIS.

Using the markdown cells in Jupyter Notebook, contextualize analyses by combining code with interactive visuals, apps, and text to create workflows that help communicate the intent and outcome analysis in a way that can make work more reproducible and transparent than just sharing the code.

Getting Started with ArcGIS Notebooks in ArcGIS Pro
In ArcGIS Pro 2.5, you can create or add a notebook to your project simply by choosing Insert > New Notebook to create a new notebook or add an existing .ipynb file to an ArcGIS Pro project. Open an ArcGIS Notebook file using the Catalog pane.

To learn more about ArcGIS Notebooks, see the online documentation at https://bit.ly/31IBskx, look at the GeoNet ArcGIS Pro community pages, and follow @ArcGISPro on Twitter.

About the Authors
Lipika Gimmler is the product marketing lead for Esri’s suite of spatial data science products including ArcGIS Notebooks, the ArcGIS Python libraries, R-ArcGIS Bridge, and ArcGIS GeoAnalytics Server. Prior to working at Esri, Gimmler was a geospatial business analyst and marketing manager at a Fortune 500 company, where she used spatial science to tell data-supported stories and make informed business decisions.

Shannon Kalisky is the lead product manager for analytics and data science at Esri, where she covers Esri products related to Python, R, big data, machine learning and artificial intelligence, and analytics across the ArcGIS platform. Before coming to Esri, Kalisky was a GIS analyst who used spatial analysis and visualization to solve problems for a wide range of organizations. In addition to applied analytics, her favorite topics are the use of spatial data science in business, ethics, and law.

ArcGIS Notebooks for ArcGIS Online Beta

ArcGIS Notebooks is also available in beta within ArcGIS Online. Users can leverage ArcGIS Notebooks to access standard analysis tools through the ArcGIS API for Python as well as access more than 1,400 geoprocessing tools via ArcPy. ArcPy Python libraries can be combined with hundreds of open-source Python libraries and be used to solve complex analytical problems.

In ArcGIS Online, there are three options for ArcGIS Notebooks:
- Standard
- Advanced
- Advanced with GPU Support

During the public beta, activities such as running analysis using a built-in tool or accessing premium content from the ArcGIS Living Atlas of the World, will still consume credits as they normally would.

The Standard option, an ideal one for administrators wishing to automate processes, includes the ArcGIS API for Python and open-source Python libraries. This option consumes less compute and memory resources than other options. After the beta ends, ArcGIS Notebooks Standard will require no additional credits to create or run.

The Advanced option, which includes ArcPy, in addition to the ArcGIS API for Python and open-source libraries, provides a moderate amount of compute and memory resources and is suitable for most workflows. After the beta ends, ArcGIS Notebooks Advanced will consume credits to create or run.

The Advanced with GPU Support option adds dedicated GPU infrastructure and capabilities in addition to ArcGIS Python and open-source libraries, which allows for computationally intensive deep learning workflows to be performed such as object detection and pixel classification. After the beta ends, ArcGIS Notebooks Advanced with GPU Support will consume credits to create or run.

Learn more about ArcGIS Notebooks in ArcGIS Online at go.esri.com/arcgisnotebooks-online.
Within just four years, The Texas Natural Resources Information System (TNRIS), a division of the Texas Water Development Board, created a standardized, nearly statewide database of basic land parcel information and address points. At the project's outset, the availability of digital land parcel information from county appraisal districts was restricted for a variety of reasons. TNRIS made this data, as well as address point data, readily available as online services through an ArcGIS Hub site. Land parcel and address points are fundamental to government activities such as state lands management, transportation, water resources, public safety, and emergency response.

The 2016 release of The Texas Geographic Information Landscape, a report by the state's geographic information officer (GIO), identified land parcels and address points as high-priority datasets. This launched TNRIS on its journey to aggregate and standardize this data and make it available. The mission of TNRIS is to bring together the Texas GIS community at all levels from all areas of the state to identify and prioritize geospatial data needs; establish consistent standards to facilitate interoperability; and serve timely, accurate, and accessible data.

Data transformation can be intimidating and can include appending, standardizing, and analyzing geospatial data from...
multiple sources to create various outputs. The transformation of most of the datasets was completed using Data Assistant, an ArcGIS Pro add-in that comes with the Community Parcels ArcGIS Solutions for State Government.

While the number of geoprocessing tools in ArcGIS Pro seems to be endless, Data Assistant proved to be an exciting and useful transformation tool. Data Assistant includes tools that have been optimized for migrating data from a source dataset to a target dataset that may have a different schema. While it is promoted as a land parcel and address point aggregation tool, it can be used to transform other geospatial datasets into a target schema. The schema of target datasets for this project was developed by TNRIS with input from more than 30 Texas stakeholders and informed by industry standards and best practices.

Other options for transformation included FME Desktop and the ArcGIS Data Interoperability extension (a subset of FME) for ArcGIS Pro. While these other options were viable, they come with additional costs and/or learning curves. The amount of time it took to learn Data Assistant was negligible and comparable to learning a new geoprocessing tool.

The process of transforming data using Data Assistant is straightforward. First, create an empty feature class of the target schema that includes a metadata shell and field descriptions. Then create a unique ArcGIS Pro project for each source area, and import source and target datasets into the geodatabase.

Load Data Assistant in ArcGIS Pro. Choose New File from the Data Assistant ribbon, point to the original data and target data, and save in the ArcGIS Pro project. Load the configuration file in Data Mapper, and map the source data fields to the target data fields. Set values or perform functions, such as Left 5 for zip, at the bottom of Data Mapper, and run Append Data. If for some reason the tool cannot process the data, there will be an explanation in the geoprocessing history log.

Data Assistant saved TNRIS time and money by quickly processing hundreds of datasets. Also, the source-target configuration file in Data Assistant can be reused if the source and target schemas do not change. This reproducible workflow will facilitate the ongoing annual updates to statewide land parcel and address point datasets in Texas.

By the beginning of 2020, the TNRIS DataHub (data.tnris.org) contained nearly statewide coverage of land parcels and address points. Datasets are accepted as is from authoritative sources, the data is standardized into a common schema, and then it is shared with the public.

Currently, the TNRIS Strategic Mapping Program, or StratMap, (tnris.org/stratmap) aggregates statewide land parcel and address point datasets on an annual basis. StratMap outputs land parcels from more than 245 appraisal districts and approximately 10 million address points across Texas.

About the Author

Ilyanna Kadich joined TNRIS as a geographic data coordinator after almost 20 years in the Texas location intelligence community. Her experience with municipal, regional, and private organizations gives her a unique perspective on data creation, integrity, and integration. In her current role, she leads initiatives for statewide datasets such as address points and land parcels. She holds a master’s degree in public affairs from the Lyndon B. Johnson School of Public Affairs at The University of Texas at Austin and a bachelor’s degree in geography from Texas State University.
The goal of NG9-1-1 is to allow voice, text, or video calls by the public to emergency services via internet protocol-based networks and transfer those calls to Public Safety Answering Points (PSAP). The transition to NG9-1-1 is ongoing and has been implemented (as of this writing) at the state level in California, Arizona, Texas, Montana, Illinois, Missouri, Virginia, and Florida.

GIS data will be critical when switching to NG9-1-1, because it will be used in two core services of NG9-1-1. GIS will be used in the emergency call routing function, which will dictate which PSAP will receive a 9-1-1 call, and it will also be used in the location validation function, which dictates if an address can be routed to a location. To support this, the NENA Standard for NG9-1-1 GIS Data Model (NENA-STA-006.1-2018) was developed. It was approved in 2018.

The author is a GIS analyst for the Brevard County Board of County Commissioners, Florida, Emergency Management, which provides best practices for making the transition to NG9-1-1.

The Brevard County 911 Administration recently used the NENA Standard for NG9-1-1 GIS Data Model to prepare its address and road layers for transitioning to NG9-1-1. This model
Focus

An excerpt from the Road Centerline attribute table description in the NG9-1-1 GIS Data Model.

Each of these fields will have to have a specific width, field name, and field type. Fields fall into three different categories: mandatory, conditional, and optional. Mandatory (M) fields must hold an attribute and cannot be left blank. Conditional (C) fields hold an attribute if that attribute exists. Optional (O) fields may or may not be provided.

Who Uses Your GIS Data?
NENA requires that the road centerline and site/structure address point layer be ready for NG9-1-1 implementation. More than likely, these two layers are not only used in your 9-1-1 system but also by other agencies in your organization. Replacing the current fields with the required NENA fields would cause issues for those agencies, especially when this data is used with third-party vendors that need certain fields in specific formats.

To avoid disrupting the workflow of other agencies, initially you might want to add NENA-required fields to your data without deleting existing fields. This gives other agencies time to work with their third-party vendors to switch to those new fields. Eventually you will be able to delete the old fields. Maintaining two sets of fields might sound like a lot more work, but by using Esri’s Attribute Assistant in ArcGIS Desktop or attribute rules in ArcGIS Pro, you will only have to manually fill out one set of fields and the rest will be automatically populated.

How Will You Get Your Data NG9-1-1 Ready?
To add the new fields and populate them with data, you want to consider using a model. Since your model will be rather big and time-consuming to create, using ModelBuilder lets you slowly finish it. Your model will incorporate many Add Field and Calculate Field geoprocessing tools. Use

What Should Your Attribute Table Contain?
The NG9-1-1 GIS Data Model calls for the street layer to have 52 fields and the address point layer to have 46 fields. Each should be used when preparing GIS data for migrations to NG9-1-1. The model specifies how fields should be named, what data needs to be in each field, the field type, and the field width. To prepare your organization’s GIS data for use by NG9-1-1, you will need to answer the following questions:

• What should your attribute table contain?
• Who uses your GIS data?
• How will you get your data NG9-1-1 ready?
• Where do you maintain your GIS data?
• What does each field mean?

An excerpt from the Road Centerline attribute table description in the NG9-1-1 GIS Data Model.

<table>
<thead>
<tr>
<th>Descriptive Name</th>
<th>Field Name</th>
<th>M/C/O</th>
<th>Type</th>
<th>Field Width</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parity Right</td>
<td>Parity_R</td>
<td>M</td>
<td>P</td>
<td>1</td>
</tr>
<tr>
<td>Street Name Pre Modifier</td>
<td>St_PreMod</td>
<td>C</td>
<td>E</td>
<td>15</td>
</tr>
<tr>
<td>Street Name Pre Directional</td>
<td>St_PreDir</td>
<td>C</td>
<td>P</td>
<td>9</td>
</tr>
<tr>
<td>Street Name Pre Type</td>
<td>St_PreTyp</td>
<td>C</td>
<td>E</td>
<td>50</td>
</tr>
</tbody>
</table>
the Calculate Field geoprocessing tool to calculate data for a newly added NG9-1-1 field using an existing field and modifying its format as required.

Where Do You Maintain Your GIS Data?
Once you are done building your model, you can run it on live data. If your data resides in an ArcGIS Enterprise environment, make sure to analyze and compress your data once the model finishes running. Making this many changes to your dataset will slow down your features when editing them in ArcMap or ArcGIS Pro. You may not be able to populate some fields using your model, so you will need to finish them manually. To maintain the best performance, make sure to run analyze and compress once you finish each field.
What Does Each Field Mean?
When you are ready to share your data with other agencies that use it daily, make sure you let them know about the data in each new field. Since you will replace current fields with required NENA fields, they will need to know which field will contain the data they currently rely on. The NENA Standard for NG9-1-1 GIS Data Model document has a description for each field that you can use to populate the metadata for your features. This should help them find the data they need.

Conclusion
It is an exciting time to be working as a GIS professional in the 9-1-1 world. The shift from Enhanced 9-1-1 to NG9-1-1 places a lot more importance on your GIS data. While the transition needs to be made as quickly as possible, make sure that you don’t leave anyone who uses your data behind. Because street and address layers are crucial in any location-based application, a lot of outside agencies will be using them. It’s important to let them know about drastic changes to the attribute table well in advance.

About the Author
Tim Witt has a bachelor’s degree in geography from the University of South Alabama and more than 10 years of experience with geospatial technologies and Esri products. He worked for the University of South Alabama from 2008 to 2009 and currently works as a GIS Analyst III for the Brevard County Board of County Commissioners, Florida, Emergency Management. He can be reached at tim.witt@brevardfl.gov.
A Wisconsin county devised a system to improve the quality of its recycling program using GIS for identifying and educating citizens who contributed unacceptable items.

The Land Resources division of the Department of Parks and Land Use at Waukesha County, Wisconsin, oversees a multijurisdictional recycling program that includes 27 municipalities within its borders. For several years, Waukesha County owned a material recovery facility (MRF) that sorted collected materials and then marketed them to various mills to be used for new products.

The county facility was reaching the end of its life as was a similar facility operated by the City of Milwaukee. After extensive studies, it became clear that Waukesha County and the City of Milwaukee should coinvest in a jointly funded MRF. Under a collaborative agreement, the single-stream facility for processing fully commingled recyclables began operating in March 2015. After single-stream bins and educational materials were distributed to county residents, haulers resumed collection operations using automated collection vehicles.

The single-stream program has been highly successful. Every year, it keeps 30,000 tons of material out of landfills by processing it for recycling.

However, it is not a perfect system. Nonrecyclable or contaminated items are undesirable and expensive to process or re-sort. Inbound material contamination has been on the rise.
At the same time, allowable contamination percentages in outbound material have, in some cases, fallen to as low as 0.5 percent. Soft demand for recycled raw materials allows buyers to more closely scrutinize material for contaminants. Materials turned away by buyers result in lost income for the county. It also diminishes the county’s credibility as a quality source of recycled material even as it competes in an already tight market space.

Unacceptable materials residents place in recycling bins are the source of contamination. Plastic bags, hoses, and propane tanks are just a few examples of these materials. Noncompliant materials, such as bowling balls, automotive brake rotors, and even deer carcasses, have come through the sorting line at the MRF. In addition to the cost of properly disposing of these items, they can potentially damage expensive sorting and compacting equipment and cause bottlenecks in processing as repairs are conducted.

**Addressing the Problem—Literally**

Waukesha County implemented an educational program called Recycle Right, focused on public outreach and education. Its goal is encouraging recycling, but perhaps as important is educating residents so they know which items are acceptable and which are not.

In addition to social media blasts, postcards and flyers were sent to residents with clarification on proper recycling practices. Truck drivers were instructed to use reminder tags on offending carts. Drivers were reluctant to do this because the process was time-consuming and put drivers at risk when exiting vehicles.

To further improve the purity of recycled materials received, Analiese Smith, recycling and solid waste supervisor for Waukesha County, turned to the Land Information Systems (LIS) division for assistance in locating, identifying, notifying, and educating residents who placed nonconforming items in recycling bins. Smith had seen GIS used for other applications at the county and thought it might be a good fit for the Recycle Right initiative.

At an initial assessment meeting, Smith described the situation. She explained that some trucks allowed the drivers to see materials as they tip it. Other trucks are equipped with remote cameras that point toward the receiving bin of the vehicle, which allows drivers to see obvious contaminants and nonconforming items.

Once the LIS staff members had a clear understanding of these logistical parameters, they inquired whether drivers would have...
Workers at the Waukesha County and the City of Milwaukee jointly funded MRF facility.

An executive-level dashboard provides a concise aggregation of data on offenders.

access to portable tablets for data capture. One of the two hauling contractors already had tablets in its trucks for other purposes. The other hauler agreed to purchase tablets if needed to help increase compliance.

Attending the Esri UC Pays Dividends
At the 2019 Esri User Conference (Esri UC), the LIS staff heard about a new product called ArcGIS QuickCapture and thought it might be useful for the project. The QuickCapture interface is simple. Large, single-function buttons are used for on-the-move data collection. Chris Dickerson, an LIS analyst, was tasked with designing the application and its related data model. The data structure was kept simple. Initially, a single point feature could have three core subtypes: (1) visible contaminants, (2) bagged materials, and (3) visible contaminants and bagged materials. A fourth subtype, compliant, was included so drivers could note locations of known offenders who had cleaned up their bins.

After the application was designed, the LIS and Land Resources/Recycling staff did some localized testing for a few weeks to see if the locational accuracy was good enough using phone and tablet GPS technology. Testing revealed that QuickCapture performed well, and point locations were deemed accurate enough for the purposes of the application.

Python + Geoprocessing = Data Enrichment
With some test data to work with, Dickerson wrote a script in Python that takes the x,y point feature and, using the Near geoprocessing function, finds the nearest parcel polygon. Once a selection set is complete, the script joins the parcel polygon with the...
resident address point, using the tax key number as the common field.

Next, the script exports the joined tables into a Microsoft Excel spreadsheet that is emailed to the recycling staff. Using the spreadsheet and mail merge in Excel, recycling staff members create the mailing labels for postcards that gently remind offending residents of recycling guidelines.

A Dashboard Brings It Together

In September, a pilot project lasting over a month was undertaken. A single truck in the hauler fleet collected the location points for offenders, and the card notification process was initiated and tested. Anticipating that the full implementation of this plan would generate a large, dynamic dataset, LIS supervisor Jim Landwehr requested that Dickerson to put together a Recycle Right Operations Dashboard.

Dale Shaver, director of Parks and Land Use, is a big proponent of data tracking, quantification, and visualization as part of his ongoing initiatives to better serve the citizens of Waukesha County. Operations Dashboard for ArcGIS provides an executive-level look at data distribution and transaction-level trends in real time using interactive graphs, charts, and heat maps.

Within a few days, Dickerson assembled an intuitive and informative dashboard for the recycling staff’s review. Staff members were excited by the easy-to-use dashboard that gave them a deep-dive lens into their data. The graphs, charts, and maps in the dashboard are linked, so clicking on one component changes the data in the other panels dynamically to make the data easily discernible to users.

Another advantage of the dashboard is that it can be used to brief supervisors, managers, and elected officials on the progress of the initiative. It provides tangible numbers for reports and can even be used to educate the public on problem areas and contaminant trends over time.

With a successful pilot project, the Land Resources/Recycling division is preparing to equip every truck in the contractor fleets with the QuickCapture app. The division is preparing to deal with the projected increase in contaminant locations and the efforts required to mail reminder cards to residents at those locations. While a 30 percent decrease in contaminant material is an aggressive goal, the division hopes that significant progress can be achieved through the educational and awareness focuses of the Recycle Right program. Using GIS to help zero in on offending areas is just one small part of a broader initiative toward a greener county and a better planet.

For more information on Waukesha County’s Recycle Right QuickCapture application, contact Jim Landwehr at 262-548-7946.

About the Author

Jim Landwehr has more than 30 years of experience in the GIS and AM/FM mapping industry in both the public and private sectors and is GISP certified. He has been working with Esri software for over 20 years and is proud of his division’s accomplishments, which include two Esri Special Achievement in GIS (SAG) Awards in 2004 and 2018. Landwehr earned a bachelor’s degree in geography/anthropology from the University of Minnesota. He also enjoys writing and has published two memoirs and five books of poetry.
Connecting the Built and Natural Environments with 3D GIS

By Jim Baumann

The City and Urban Design team at Gensler has recently explored the capabilities of GIS to create plans, visualize scenarios, and support collaboration and decision-making. A renowned international design firm, Gensler is the largest architecture, design, and planning firm in the world. The company designs large-scale, mixed-use urban communities as inviting places for people to live, work, and play.

While GIS is commonly used in the urban planning and design process, it is normally used for site selection and analysis. Planners and designers use GIS to understand the topography, hydrology, demographics, and government regulations of an area, which informs the design of the project.

During the complex processes of urban planning and design, data collection, analysis, and visualization efforts are used to support decision-making, according to Le An, a senior urban planner and urban designer at Gensler’s Washington, DC, office. She notes that the rapid development of 3D and interactive GIS technology benefit urban planners, who can now adopt a more integrative and dynamic approach to managing and moderating planning and design tasks. This better serves the communities in which these projects are being built.

Creating a basemap in ArcGIS Pro that includes existing building footprints, elevation, zoning, land use, and transportation networks provides context for proposed projects.
Using ArcGIS Pro and Esri CityEngine, the team quickly converts 2D designs into detailed, large-scale 3D city models.
After approval, GIS-based 3D models, as well as related plans, are handed off by the urban designers to the architect so that the design can be further developed in the building information modeling (BIM) environment. A construction company uses the BIM model to build the project. BIM can include extensive smart facilities data that can be used for architectural design and engineering; mechanical, electrical, and plumbing (MEP) applications; structural engineering; and building construction.

Because many municipalities and local governments maintain open GIS data portals, Gensler can obtain high-quality data about parcels, lots, land use, water bodies, and roads, transit lines, and bus stops. Environmental data includes contours, topography, hydrology, and fault lines.

Building footprints that include height attributes are also available from the portal. Using the CityEngine procedural modeling tool, thousands of 3D buildings can be quickly generated from the
building footprints for design concepts.

“I think design has the power to connect together the existing built and natural environments with technology to create a more livable space in our future communities,” concluded An. She feels that GIS has allowed the team to better understand, evaluate, and analyze what is behind the physical appearance of communities, providing a deeper understanding of how a community works through analyzing data about it.

In the future, An would like to collaborate with the firm’s architects. She would like to take the detailed model in Revit or BIM and load it into her 3D model in ArcGIS Pro so that architects can better understand how their designs impact the community. Her team could help them with additional analysis. She believes that ArcGIS Urban will be a great addition to this rapidly evolving technology and “will continue to push the envelope of smart urban planning and design.”

About the Author

Jim Baumann is a longtime employee at Esri. He has written articles on GIS technology and the computer graphics industry for more than 30 years.

₂D designs can be quickly converted to detailed, large-scale 3D models with CityEngine.

💡 Modeling viewsheds in 3D views gives a real understanding of a design’s impact on the surrounding environment.
In 1994, I started my career in GIS by working at a regional planning commission. I still think about it every time I work with planners, speak at a planning conference, or hold a workshop at the APA [American Planning Association]. The concept I keep coming back to is how isolated GIS was from planning professionals. At the time, it required hefty investments in hardware, software, and training—quite honestly at a level that didn’t make sense for most planning professionals. They could more efficiently farm out their work to the GIS technician sitting in the back cubicle and teach him/her about the right shade of yellow to use for single-family residential land use. (That was a fun lesson.)

Today’s planning department can’t work like that. Technology and the expectations that go with it have changed exponentially. The most inspiring part of today’s planning environment is that planners don’t also have to be GIS professionals. This bothers far too many GIS professionals who have been in this field a long time. They are unhappy they aren’t the only ones who can leverage data science. It’s an antiquated and unsustainable stance that will lead them to obsolescence in this field. That’s not a theory. I’ve seen it in real life more than a few times.

One of the things I learned while working in the planning field was how interconnected a planner’s decisions were with other local and regional government departments. Even a rather simple subdivision review wasn’t just signed off by yours truly. It required analysis and input from public works, parks, utilities, transportation, and sometimes public safety departments.

The evolution of Web GIS now means that planners can access the tools they need to design, analyze, and compare development scenarios before the first site plan enters the office. It means the legal requirements of public notification can be handled and recorded in-house. It
means that the numerous stakeholders I mentioned, as well as local government administrators, have focused, secure apps to analyze and collaborate in this process. And all of this can occur without installing traditional desktop GIS software on the planner’s desktop. It doesn’t require weeks of training or a powerful machine to run, either.

Planning departments in local governments are increasingly being tasked with participating in resilience planning and economic development efforts in addition to their traditional roles of reviewing current planning projects and maintaining a long-range plan. This makes collaboration even more critical because more stakeholders are involved.

Whether dealing with a variance, rezoning, or a complete update to the comprehensive plan, a planner has a story to tell. That’s why I love ArcGIS StoryMaps. A planner can take a complex story and use story maps to make it visually appealing and relatable. This brings incredible value to the table. Instead of printing out dozens of pages that will likely never be read and putting them in a binder on a shelf, this easy web-based app can easily communicate the story to the public, administrators, developers, and the media.

Finally, one of the more underrated benefits of Web GIS is the way it enables true citizen engagement—a genuine partnership between citizens and their government. It meets modern expectations with modern technology. You can’t tell the public anymore that the only way they can communicate with the planning department is to show up at the public hearing or make a call to the department.

The Web GIS pattern provides easy ways to generate purposeful open data centered around initiatives that matter to the public such as a downtown redevelopment project or a comprehensive plan update. It provides a way for residents to not only be notified, but also to provide feedback through surveys, maps, and other apps. This pattern also provides a level of transparency for the planning department regarding its methodology by providing the data-driven approach behind decisions. I see the role and benefits of Web GIS in a smart system for planning from multiple perspectives: executive, planner, field staff, and the public.

For clarification, this doesn’t mean that desktop GIS software is obsolete. It means just the opposite. It means that the content desktop GIS creates—the data, analysis, models, and maps—has a much wider audience than ever before. So, it’s inspiring to learn how most planning students coming out of college programs have at least a nominal exposure to GIS in their curriculum. This new pattern is not creating more work for planners. It’s taking the workflows already in place and optimizing the way those workflows are completed. Moreover, these apps work together seamlessly. They are not a bunch of disparate apps that slow down overall processes.

This type of cohesive platform can foster an environment of collaboration between stakeholders and planners on initiatives—something that planning departments have probably never really had before.

About the Author
Keith Cooke is an Esri account executive and former planner and GIS manager. He works on national planning and economic development initiatives at Esri. He has conducted nearly 100 hands-on workshops for planners at APA conferences.
Use Parts of the New Map Viewer to Build Your Own Better Apps

By Julie Powell and Bjorn Svensson

Have you played around with the new Map Viewer in ArcGIS Online yet? It offers a highly interactive mapping experience for creating impactful visualizations of your data.

The good news for developers is that the powerful data exploration tools, mapping styles, interactive filtering, and pop-ups—even the ability to save web maps—in the new Map Viewer were built with the ArcGIS API for JavaScript. That means that you can create the same experiences for users of your own custom apps.

Let’s look “under the hood” of the new Map Viewer to learn how the ArcGIS API for JavaScript was used so you can use new pop-ups, labels, widgets, data exploration, vector tile styling, and web map saving capabilities in your next web mapping app.

Pop-Ups

In the Map Viewer, pop-ups play a key role in how end users explore data in a map. The new Map Viewer offers a better pop-up experience. Pop-ups are responsive and dockable. Attachments accessed from pop-ups automatically rotate and display thumbnails for document types.

In the ArcGIS API for JavaScript, pop-ups are defined in the API using a pop-up template. You can organize content any way that you want, including multiple blocks of text, fields, attachments, and media such as charts. In addition, pop-up actions are a handy innovation in the API. Pop-up actions are a very simple way of adding a button to the pop-up to execute custom code when clicked. For example, you might add an action that performs a buffer around the selected feature and locates and highlights all the points of interest within that buffer.

Labels

In the Map Viewer, there is a lot of flexibility when it comes to labels. You can use multiple label styles for different configurations. For example, labels for sales numbers for specific stores can be shown as black if increasing and red if decreasing. You can customize labels with specific fonts and colors that match symbology elsewhere in the map, display labels stacked in multiple lines, or specify vertical and horizontal offsets for labels. Map rotation is
supported so when the map is rotated, client-side labeling does not rotate and is properly displayed and easily read.

_in the ArcGIS API for JavaScript_, the added labeling flexibility in the Map Viewer is due to the labeling enhancements in the API. Developers can define where a new line is placed by using either an ArcGIS Arcade expression, TextFormatting.NewLine, or by specifying the maximum width for individual lines. Labeling styles are defined as label classes in the API and can be conditionally displayed based on criteria that include aspects such as attribute values or scale.

**Widgets**

_in the Map Viewer_, the user experience depends heavily on widgets in the API. If you’ve been developing with the API, you might recognize many of these widgets, which have been part of the API for several releases. However, some widgets are being developed concurrently with the Map Viewer to create tools and workflows that improve the mapping experience. In these cases, the Map Viewer is updated first. The new widget is available in the API in a subsequent release so developers can take advantage of the same widgets in their apps. The measure, coordinate, print, smart mapping sliders, time animation, editing, pop-up, search, and directions are some of the widgets that debuted in the Map Viewer.

_in the ArcGIS API for JavaScript_, widgets are designed with the user and the developer experience in mind. An API developer works with a product engineer who really understands user needs and use cases. The API developer also teams up with a UI/UX expert, so the new widget will provide an elegant and responsive user experience. API widgets are created and positioned in apps with a few lines of code, which helps developers be productive when building UIs.

The old Map Viewer used widgets from the 3.x version of the API. The design of these widgets was refreshed when the new Map Viewer was built. For example, the print widget in the new Map Viewer offers more formats, sizes, and other options.

Developers can style a widget or use a theme to style all the widgets in an app. More advanced developers can choose to fully customize the UI of an API widget (referred to as the widget view) using the source code Esri has shared on GitHub. It is available at https://bit.ly/2TWKb9A.

**Data Exploration**

_in the Map Viewer_, tools let you explore and better understand data. Making the map used to be the goal. However, new map exploration tools and fast map display let you use the mapping process itself to better understand your data and turn it into a more meaningful information product.

The new Map Viewer maps more data and can display that data faster. In the old Map Viewer, changing color themes used to take 10 seconds. In the new Map Viewer, changing color themes is instantaneous. The user can get creative without being penalized in terms of productivity. Seemingly immediate map updates let the user play around with various smart mapping styles and experiment with the attributes that drive the visualization.

The immediate feedback from interactive filtering helps users explore data on the map and find data of interest. Filtering provides statistics such as the count of the records, sum, minimum, maximum, and average. As a filter is created, it is applied to the map display, emphasizing matching data and de-emphasizing nonmatching data.

Smart Mapping capabilities in the Map Viewer create a quality visualization by default by automatically picking a color scheme that matches the basemap used, whether it is a raster or vector basemap. The user can accept that styling or modify the color

↓ The widget responsible for improved printing in the Map Viewer is also available for use in custom apps built with the API.
In the ArcGIS API for JavaScript, hardware acceleration is leveraged via WebGL to rapidly render datasets of any size, from small to very large. WebGL also allows the attribute values used to render each feature to be updated quickly without reprocessing the geometries, eliminating noticeable artifacts or flashing. Build a great user experience using this capability. Provide tools that let end users dynamically switch between the attributes and rendering styles used for thematically mapping an area of interest.

The API contains an in-memory database so client-side filtering, querying, and statistical calculations can be performed. The in-memory database can process any SQL WHERE clause and spatial relationship operation that can be done in a server-side query. Everything is performed client side, which allows a user experience to be immediate and provide feedback from interactive filtering helps users explore data on the map and find the data of interest.

The ArcGIS API for JavaScript exposes the Smart Mapping API so the developer can create map exploration tools.
The ArcGIS API for JavaScript exposes the Smart Mapping API so the developer can create map exploration tools. For example, you might want to let end users select from a list of attributes to thematically map data and use Smart Mapping tools to automatically select a style that works well with the data and matches the basemap.

**Vector Basemaps**

ArcGIS Online provides a variety of vector tile basemaps. Although screen resolution varies across devices, vector tile basemaps will always display crisply. Vector data and the visual style are separate, so vector tiled layers can be customized to the map, which drives dynamic, interactive cartography. Because the process of creating and updating is a lot faster for vector tile layers than it is for raster tile layers, Esri makes more frequent updates to vector tile basemaps.

*In the Map Viewer*, the default basemaps are vector, rather than raster. This means a basemap can be copied and styled in any way using the Vector Tile Style Editor, which is accessible from within the Map Viewer.

*In the ArcGIS API for JavaScript*, you can bring in any vector tiled layer with its default style or with a custom style that you’ve created. The API lets you dynamically change the style via code.

**Creating and Updating Web Maps**

*In the Map Viewer*, the configuration of layers, style information, pop-ups, and view state (e.g., initial extent) is saved as a web map. The power of the web map is that once it is defined using a simple authoring experience, it will be consistently displayed in all ArcGIS clients with little effort.

*In the ArcGIS API for JavaScript*, the same web map saving capabilities in the new Map Viewer are available. When a map is saved, the new Map Viewer calls the API method `webmap.save()` and `webmap.saveAs()`. While this might seem trivial, this gives you the power to create simplified or more focused workflows for web map authoring from within your own app that can range from adding or removing a layer to updating the rendering to simply saving the view state.

**Play and Get Inspired!**

The new Map Viewer is growing and evolving with each release. As new features are added, they also become part of the ArcGIS API for JavaScript, if they weren’t already available. Play around with the new Map Viewer and see what you like. Then look at the JavaScript API samples at https://bit.ly/33pNxMo to learn how you can build those same capabilities in your app.

**About the Authors**

Julie Powell is a technical product manager for the ArcGIS API for JavaScript. She has more than 18 years of experience working with software development, delivering solutions for both enterprise and consumer markets. Powell has worked on a wide range of projects and consulting endeavors, including serving as a technical lead for web mapping solutions for strategic customers. She interfaces with a wide user community to maintain awareness and insight into GIS community needs, meanwhile contributing feedback to development teams to help ensure users can be successful in building state-of-the-art, purposeful solutions using ArcGIS software.

Bjorn Svensson is currently the lead product engineer for the ArcGIS API for JavaScript, which is the key front-end component of the enterprise ArcGIS platform. He has more than 20 years of experience in web mapping.
This was the 15th annual event “for developers, by developers.” Jim McKinney, chief technology officer for ArcGIS Desktop and Esri president Jack Dangermond opened the session. Dangermond noted that the work of developers is creating “a digital transformation using geographic science.”

Following an overview of the ArcGIS platform by Esri director of software development Sud Menon, more than 25 of Esri’s development staff gave presentations that highlighted improvements in data exploration and visualization, the incorporation of real-time data, the application of data science techniques, better scalability, more automated workflows, and an enhanced developer experience.

**MORE WAYS TO MAKE DATA MEANINGFUL**

The ArcGIS API for JavaScript was featured in several presentations. Its enhanced capabilities, which are reflected in the ArcGIS Online Map Viewer beta, can be used by developers to make amazing maps through dynamic and data-driven styling. Updating the API for modern browsers means developers can build fast and powerful interactive apps for data exploration and visualization.

Furnishing information from data rapidly in a readily comprehensible fashion was the theme of a presentation on the new ArcGIS Dashboards. Dashboards have become tremendously popular as a tool for communicating with executives and the public. Using charts, indicators, and gauges, dashboards can summarize complex datasets, presenting information simply. ArcGIS Arcade can now be used in ArcGIS Dashboards to provide more control over display and calculations.

The ArcGIS Runtime SDKs are engineered so developers can build field apps for gathering data from the field that feeds dashboards and visualizations. New releases of the ArcGIS Runtime support apps that can work offline or function with intermittent connectivity and employ strategies that take the load off the server.

**TOOLS FOR DATA SCIENCE**

ArcGIS supports a complete data science workflow. ArcGIS is used in data preparation/engineering, visualization and exploration, spatial analysis, artificial intelligence integration, and big data analytics using modeling and scripting and provides a unified way to train and use deep learning models. Training data can be directly consumed in ArcGIS Pro, ArcGIS Image Server, and ArcGIS Notebook Server.

Presentations during the Plenary demonstrated how the arcgis.learn module of the ArcGIS API for Python can be used to extract location and other information from lidar, video, unstructured text, and multispectral imagery. The natural language processing that is built into the arcgis.learn module was showcased by Lauren Bennett, lead product engineer for spatial analysis at Esri. She extracted location and other attributes from unstructured text data contained in crime reports and mapped it.

Other improvements for data science were announced. R-ArcGIS Bridge can access remote data sources and call and run geoprocessing tools inside R. Conda now supports R Notebooks. ArcGIS Notebooks is now part of ArcGIS Pro, making spatial analysis in a data science context more accessible and approachable and providing seamless access to powerful open-source Python libraries.

Multidimensional analysis, powered by Raster Analytics in ArcGIS, can be performed using tools in the ArcGIS API for Python and ArcGIS Notebooks. Raster Analytics can quickly perform analyses on large collections of multidimensional datasets through parallelization and distribution of the processing load.

**INCREASED PRODUCTIVITY**

Developers were encouraged to start using ArcPy and its Python modules for doing geoprocessing tasks in ArcGIS. Because Esri has been simplifying and adding new ArcPy geoprocessing tools, developers will write fewer lines of code to get tasks accomplished.

ArcObjects, an SDK that has been used to make powerful GIS apps and extend the platform for more than 20 years, will continue to be supported by Esri. However, developers were urged to move to Esri’s latest developer technologies: the ArcGIS Pro SDK for Microsoft .NET, the ArcGIS
Enterprise SDK for the .NET and Java platforms, and the ArcGIS Runtime SDKs.

Two builders, AppStudio for ArcGIS and the new ArcGIS Experience Builder, can produce apps with little or no coding. ArcGIS Experience Builder is a new way to build web experiences using templates and widgets.

ACCESS TO GAMING ENGINES

Euan Cameron, chief technology officer for developer technology at Esri, announced that Esri is integrating ArcGIS with Unity and Unreal Engine, two popular game engines.

The integration of ArcGIS with game engines targets extended reality (XR) experiences that combine real-world and virtual environments and the GIS needs of 3D gaming apps. Members of the large existing gaming development community have expressed a desire to get ArcGIS content into game engines to improve gaming applications.

For ArcGIS developers, this integration provides a premium rendering experience and cross-platform hardware support. The Unreal Engine and Unity game engines will bring animation, particle systems, and a physics engine to the app development environment.

Esri will build plug-ins for Unity and Unreal Engine that will provide APIs to access ArcGIS services and local data, come with SDKs to improve productivity, display and honor real-world/geographic coordinate space, integrate with the game developer experience, and come with resources such as samples and demonstration apps.

KEEPING DEVSUMMIT GOING

GeoDev webinars and tech workshops with question and answer sessions, help keep the spirit of DevSummit going year-round. Learn about upcoming webinars at https://bit.ly/3aoEzS7. The Esri European Developer Summit is currently slated for November 2020 in Berlin, Germany, but may be subject to schedule changes.
If your app is linked or embedded in a news or media site, potentially half your audience could be viewing it on a mobile device. SimilarWeb, a company that provides web analytics services to businesses, estimated that mobile devices accounted for more than 50 percent of website visits in 2018 and that people spent more than 40 percent of their time online on mobile devices.

To accommodate the shift in screen size, Esri designs ArcGIS Configurable Apps with a mobile first approach that asks, How will the app look on the smallest screen? ArcGIS Configurable Apps are available when you share a web map and choose CREATE A WEB APP or from the item details page of an ArcGIS Online web map. This article shares some tips for ensuring your app is mobile ready.

**Configure the Pop-Up**

The pop-up for a feature can provide the most detailed information in a map.
Transform the attribute data into an easy-to-read display of the most important information for your audience. In most configurable apps, pop-ups respond to screen size and can be docked at the bottom of the screen for easy reading and scrolling.

Choose Meaningful Symbology
Smart Mapping supplies choices that will highlight one or more attributes. It suggests color ramps that will show the meaning of your data. Explore Smart Mapping options and choose symbology that will emphasize what matters most in your map. Choose a basemap that gives context but doesn’t distract from the map’s main message.

Choose a Suitable Template
Esri has begun building configurable app templates using the ArcGIS API 4.x for JavaScript. These apps are responsive and provide an optimal viewing experience no matter the device. To explore these configurable app templates in the Create a web app template gallery, type “4.x” into the Search box. For a fuller overview of the newer apps, read the ArcGIS Blog post “Take a tour of Configurable Apps built with the ArcGIS API for JavaScript 4.x.”

Design for the Small Screen
Share information with text options. Title your map succinctly. Use clear supporting text in configurable app options, such as an About text box that steers users through the app. Text panels and boxes respond to the device viewport, but succinct text prevents unnecessary scrolling and interaction.

Enable only necessary tools. A variety of configurable app template tools are provided, but certain ones will support your story best. Ask yourself these questions:
• Will a legend clarify map content?
• Is a scale bar to measure distance crucial?
• Should users be able to toggle the basemap or layer list?
Put yourself in the shoes of your mobile device user when selecting app tools.

Test Your App Many Times
Test, then test again. After creating your map and configuring your app, simulate your app on a mobile device with your browser’s developer tools. In a Chrome browser, open Chrome’s developer tools by pressing F12 or Ctrl+Shift+I. Then, click Toggle device toolbar (Ctrl+Shift+M) and select a mobile device to emulate. This will change the viewport so you can see how the application behaves and appears on a specific mobile device.

Access Your App on Mobile Devices
While the browser tools provide a quick view into the app’s appearance on a mobile device, the only way to replicate what your users will experience is to view the application on a real mobile device. Don’t just use one device because different mobile devices look and behave differently.

About the Author
Beth Romero is a product engineer on the ArcGIS Online team.

To locate the configurable app templates built on the ArcGIS API 4.x for JavaScript, type “4.x” into the Search box on the Create a web app template gallery page.

The only way to replicate what your users will experience is to view the application on a real mobile device.
GIS Systems Lead Response to COVID-19

By Monica Pratt

Although the coronavirus disease 2019 (COVID-19) pandemic, by definition, was a global event, like all disasters, it was experienced locally by millions of individuals who lost their loved ones, their incomes, and their sense of normalcy.

As the COVID-19 outbreak grew to an epidemic and fears of its metamorphosing into a pandemic began to be considered seriously, Johns Hopkins University (JHU) launched its COVID-19 dashboard. A team led by Lauren Gardner, an epidemiologist and codirector of the Center for Systems Science and Engineering at JHU, created the dashboard using Esri technology. It immediately went viral, with the number of visitors skyrocketing as it became the global reference for the pandemic, while Esri continued providing support to JHU.

“When disease can travel so quickly, information has to move even faster. The intense response generated by the Johns Hopkins dashboard shows how eager people around the world are to track health threats,” explained Dr. Este Geraghty. She is the chief medical officer and health solutions director at Esri. “The dashboard presents targeted, up-to-date information needed to understand the progress of a disease and makes it available in a public, easy-to-digest format.”

Early in the COVID-19 outbreak, Johns Hopkins University launched its COVID-19 dashboard which immediately went viral, with the number of visitors skyrocketing as it became the global reference for the pandemic.
Applying Geographic Technology

Organizations have been using mapping for hundreds of years—and GIS in recent decades—to understand the spread and impacts of epidemics. In this century, GIS has played important roles in tracking and helping to contain two other human coronaviruses, SARS-CoV and MERS-CoV. During the Ebola outbreak in 2013, government officials used GIS to site emergency treatment centers, manage bed capacity, and coordinate response efforts. However, GIS use for COVID-19 has been the most comprehensive and effective one to date.

The organizations that applied the geographic technology of GIS to COVID-19 ranged from local to international. The widespread use of GIS for COVID-19 response has demonstrated the power of geospatial thinking and the scalability, speed, and insight provided by GIS. More than simply mapping phenomena, GIS uses geography to furnish context for events in a common reference system. Applying spatial analysis tools, GIS brings out the relationships, patterns, and associations that are often hidden by the complexity of data.

The pandemic has also highlighted the importance of a geospatial infrastructure for effective and informed action in disasters. Johns Hopkins University’s dashboard could deliver the information on COVID-19 that everyone urgently sought because it tapped into the enterprise system for pandemic response provided by the ArcGIS platform and delivered by the Esri Geospatial Cloud. Its speed and scalability have been demonstrated by thousands of organizations around the world that stood up ArcGIS Dashboards and ArcGIS Hubs, and implemented ArcGIS Solutions for responding to the pandemic and ensuring business continuity.

A Common Mission

To help address the pandemic, Esri made all its software, virtual training, and on-call technical assistance freely available not only to all its users but also to any organization anywhere in the world that was battling the pandemic. “Addressing the pandemic can be seen as part of Esri’s common mission of bringing geographic science, GIS technology, and geographic thinking to every organization on the planet—all governments, private companies, academic institutions, and NGOs,” said Jack Dangermond, Esri founder and president, in an announcement in March 2020.

With Esri software, training, and support services came access to the vast trove of authoritative and accurate foundational data from the ArcGIS Living Atlas of the World and business, lifestyle, and other datasets. Combined with the ability of the ArcGIS platform to rapidly ingest, integrate, analyze, and visualize data from sensor, telemetry, and other real-time data sources, organizations could accurately capture the constantly changing picture of the unfolding crisis.

Thousands of organizations across the United States and in numerous countries around the world that were not already using ArcGIS adopted GIS. Esri, through its Professional Services team, has been supporting the outstanding work of local, state, federal, and international organizations as they stand up GIS systems for reacting to the pandemic. To help these organizations work as effectively as possible, Esri has been creating and releasing training materials and white papers that are specific to using GIS for COVID-19.

Esri’s Disaster Response Program (DRP) has also helped thousands of organizations. For more than 25 years, it has provided...
data, software, configurable applications, and technical support to help communities during large-scale emergencies and natural disasters. Read the accompanying article, “Esri’s DRP Lends Support to Worldwide Efforts Against Pandemic,” to learn more about the DRP.

Esri international distributors in the Middle East, Europe, Asia, and South and Central America have also supported efforts combating COVID-19 in the countries in which they work by providing technical support and training materials to help set up ArcGIS Hub sites and use ArcGIS StoryMaps.

Esri partners around the world are also playing a critical role in helping with this global disaster by contributing discounted or no-cost COVID-19 focused offerings and location-enabled software solutions, content, and implementation services.

Two new initiatives have accelerated the use of GIS to understand and halt the spread of COVID-19. Esri partnered with the World Health Organization (WHO) to provide Esri software and solutions to all international health ministries and their global affiliates, particularly those in developing countries.

A partnership with the Federal Emergency Management Agency (FEMA) has made the Esri platform available to all FEMA partners, which includes nearly all governments and nongovernmental organizations (NGOs) responding to the crisis in the United States.

To ramp up its capacity to support many more users of the Esri Geospatial Cloud, Esri has been optimizing the scalability of ArcGIS Online to handle the creation of billions of map views per day and support the load generated from ArcGIS Dashboards.

In collaboration with its partners and user community, Esri launched the COVID-19 GIS Hub, an ArcGIS Hub site that provides a collection of datasets, applications, and other useful content for planning and response. Because Hub is a software-as-a-service (SaaS) solution that is hosted in the Esri Geospatial Cloud, it doesn’t require hardware or software and greatly reduces deployment and maintenance time. Localized versions of ArcGIS Hub are available in 38 languages.

Two ArcGIS Solutions were created specifically to help organizations with COVID-19 problems. Coronavirus Response is an ArcGIS Solution that supplies a collection of apps and data designed to help users understand and manage the impacts of the pandemic on a community. The Coronavirus Business Continuity Solution is a collection of apps and data for coordinating and reporting information about employees and facilities to get organizations, whether private or public, back to normal.

As the pandemic has unfolded, Esri has developed tools that incorporate mathematical models used by epidemiologists such as the COVID-19 Hospital Impact Model for Epidemics (CHIME) model. At the outset of the pandemic, Esri developed an implementation of CHIME for use in ArcGIS Pro that leverages Susceptible, Infected, Recovered (SIR) modeling and can be used to forecast the curve of the epidemic in terms of its impact on hospitals and visualize those impacts spatially.

**Existing GIS Implementations Speed Efforts**

One of the hallmarks of the COVID-19 pandemic has been the need for speed. Its rapid spread requires not the perfect plan but an immediate one. That means actionable information, not a flood of data. GIS has been critical to the ability of state and local governments to react to the pandemic. Those that had robust, existing GIS implementations have been well positioned to pull the best data together, analyze it, and rapidly respond.

The State of Maryland rolled out its ArcGIS Hub site, Coronavirus Disease 2019 (COVID-19) Outbreak site (coronavirus.maryland.gov),
in just four hours on March 14, 2020, and didn’t incur any additional cost because Maryland already used ArcGIS as a statewide enterprise system and its GIS staff members already possessed the necessary skills.

“We were able to step up and use the technology when it really mattered,” said Julia Fischer, the State of Maryland’s geographic information officer. The good working relationship between the state’s information technology department, emergency management agency, and health department helped GIS staff deliver the right data, right away.

The State of Montana benefited from the existing statewide datasets it has maintained and made available for years. Having the right tools, processes, and foundational data layers are critical to optimizing GIS use in an emergency. Erin Fashoway, the state GIS coordinator said, “It’s a no-brainer to use GIS for emergencies. Montana has lots of them.” She sees the key to using GIS for emergencies is not to start using GIS in the middle of an emergency.

By using Survey123 for ArcGIS, Montana gathered data on local conditions throughout the state and in tribal areas that was immediately shared at the Montana Emergency Coordination Center. The information created using the state’s GIS was used by the governor’s task force to drive its decisions.

“There is no doubt in my mind that GIS should be used as a tool to plan for, mitigate, and recover from disasters,” said Fashoway. She believes that “GIS in disaster response is 100 percent necessary.”

Local government, which is the face of government for most people, had to cope with social and economic impacts that originated far away but had close-to-home impacts.

Statewide shelter-in-place orders caused millions of people to lose their jobs and incomes. At the same time, school closures interrupted the free breakfast and lunch programs many families rely on. Food supply chains were disrupted as restaurants closed or adopted limited services and hours at the same time the demand for groceries increased substantially. This dislocation for suppliers and increased demand by grocery stores was exacerbated because they have come to rely on constant shipments and rapid restocking of goods. Widespread panic buying and hoarding compounded these logistics problems, leading to empty store shelves.

The result was food insecurity that was felt early and pervasively. While it was a widespread problem, it required local action to solve. ArcGIS Hub sites and apps supplied residents with current information on local conditions and helped local governments deal with this problem.

For example, Cobb County, Georgia, a longtime, innovative user of GIS, added a web app to its ArcGIS Hub site dedicated to COVID-19 resources. It supplied up-to-date information on grocery inventories of essential items, special hours for at risk people, how crowded stores were, and how well social distancing practices were being followed for area stores. Current data was fed into the app by crowdsourcing data from residents who used Survey123 for ArcGIS to fill out surveys on stores. A story map on the site contained information on area food pantries and government assistance.

Restaurants—a source of food and local employment—have been supported by local governments using GIS. The IT
department for the City of Seattle, Washington, created the GIS-based #SupportSeattleSmallBiz app to support local restaurants. Business owners used a simple survey form to populate a web app with information on their status. A public-facing app let residents find restaurants near them and provided phone numbers, website links, and directions. The app made information on more than a thousand businesses quickly available, helping those businesses stay open, keep staff employed, and retain customers.

Recovery Needs a Geographic Context

While the COVID-19 pandemic was initially perceived as a public health crisis, its effects are rippling through society and will be long-lived. COVID-19 is precipitating an economic emergency that has effects both pervasive and growing. This secondary emergency is enmeshed with other social challenges, notably widespread homelessness.

The interrelated nature of these two issues makes GIS the best framework for holistically arriving at policies. ArcGIS tools and data can determine impacts on businesses and the economic well-being of individuals. With a better idea of these conditions, different levels of government can work together and coordinate efforts.

Regional economic recovery is going to be a collaborative process because the effects of COVID-19 don’t neatly stop at city or county boundaries. Placing data in a geographic context helps visualize relationships and perhaps new solutions. Collecting data will allow predictive modeling and shape recovery. This crisis is an opportunity for collaboration and building cooperation that could continue, limiting data hoarding and promoting reciprocal data sharing.

A Framework for Understanding and Responding

GIS professionals across the world have applied GIS in responding swiftly and decisively to the COVID-19 pandemic and demonstrated just how valuable geospatial thinking is. They showed that using a geographic framework for informing decisions is not just applying technology but helping lead organizations to a better way of dealing not only with emergencies but with day-to-day challenges.

Thousands of organizations that had not used GIS much or at all before the pandemic have successfully stood up systems in response to COVID-19 and realized concrete benefits. Geraghty sees the pandemic as an opportunity for organizations to appreciate how valuable a geospatial framework can be to them. She hopes that people will realize the value of looking at their data geospatially not only to be better prepared for the next public health emergency but to develop better methods for handling other problems.

“Taking a geospatial perspective is different. It’s a different way of thinking. It’s more than looking at a map. It’s making spatial decisions and doing spatial analysis which is different in its overall perspective from traditional analysis and statistics. Once you start to think this way, you easily see the value of it and how you can apply it to the challenges that we have at hand,” she said.

The GIS-based #SupportSeattleSmallBiz app supported local restaurants by giving them a way to easily help residents find restaurants near them and find out what they offered.
Esri’s DRP Lends Support to Worldwide Efforts against Pandemic

By Jim Baumann

Soon after coronavirus disease 2019 (COVID-19) was first detected in mainland China, requests for assistance began to pour into Esri’s Disaster Response Program (DRP).

DRP, a free service that Esri makes available as part of its corporate citizenship, is designed to help customers when their GIS capabilities are exceeded during an active incident response. It was established by Esri more than 25 years ago shortly after the 1993 Northridge earthquake in Southern California to formalize its emergency response efforts.

“During its first 25 years of operations, the Esri DRP has answered thousands of requests for assistance,” said Ryan Lanclos, Esri’s director of public safety solutions and DRP. “By comparison, we responded to about as many requests for COVID-19 support by the end of March 2020.

“Requests have come in from all over the world, from small communities to multinational organizations and global companies alike. This pandemic is affecting all of us, and I’m grateful we can offer assistance to those working on the front lines.”

More than 100 of Esri’s technical specialists are staffing DRP to support customers involved in the COVID-19 response. Among its services, DRP resolves technical support issues, provides additional software when necessary, points customers to available data, and helps configure solutions to address common workflows for crisis response. Primary requests for product support include ArcGIS Online, ArcGIS Hub, ArcGIS Dashboards, ArcGIS Desktop, ArcGIS mobile applications, and configurable web apps.

About the Author

Jim Baumann is a longtime employee at Esri. He has written articles on GIS technology and the computer graphics industry for more than 30 years.
Reallocating Resources for COVID-19 Response

By Mike Price

In late February, the spread of coronavirus disease 2019 (COVID-19) in Whatcom County, Washington, and elsewhere warranted an immediate review of two advanced life support (ALS) response and transport units located in the county.

In early December 2019, Whatcom County Emergency Medical Services (WCEMS) had begun an analysis of emergency medical services (EMS) deployments in the county to optimize the location of those medic units with ALS and consider the benefits of placing an additional unit in service at another location. Because of the COVID-19 pandemic, the need for this study was more pressing. The study used ArcGIS Network Analyst for all time-based travel analyses and ArcGIS Spatial Analyst for risk modeling. Network streets were developed from current Whatcom County transportation data and incidents, and risk times were obtained from 2018–19 response records.

Two of the WCEMS ALS units were located at Bellingham Fire Department’s Headquarters Station 1. The study determined that these units should be reassigned to separate quarters to increase response and transport efficiency and reduce risk of cocontamination from COVID-19.

Scenario 1 shows travel interval areas with two medic units at Bellingham Station 1, one unit at Medic Station 10, and one unit at Medic Station 45.

The study modeled response and transport patterns for all six stations, including Station 1, based on mapping 2019 EMS incidents. Optimized and overlapping travel polygons were modeled to show individual stations and optimized combined station response patterns within specified time intervals of 4.0-, 6.0-, 8.0-, and 10.5-minute travel intervals from stations to incidents. Stations 3 and 6 were quickly identified as viable relocation alternatives. Station 3 is slightly south of the downtown core, near Western Washington University and the Fairhaven community. Station 6 is on the east side of Interstate 5, which bisects the city and is close to major shopping centers and several large adult care facilities. A total of four scenarios were modeled: the initial conditions and three alternative locations for Stations 3 and 6.

Scenario 1 modeled the initial conditions and associated response times with two units at Bellingham Station 1, one unit at Medic Station 10, and one unit at Medic Station 45.

Scenario 4 modeled an optimized deployment of ALS medic units. The travel intervals expand in Bellingham’s southern, eastern, and northwestern areas. Since Medic Stations 10 and 45 were not moved, northern and eastern areas remain unchanged.

By relocating medic units 1 and 2, the number of response destinations increased by 213 percent, and transport origins increased by 210 percent over the initial conditions for four-minute travel areas.
Scenario 4 models optimized travel areas that substantially increase the number of responses and transports accomplished within 4.0-, 6.0-, 8.0-, and 10.5-minute travel intervals. Response destinations and transport origins for all other travel intervals improved significantly.

Scenario 4 was used to redeploy units in March 2020. Actual response and transport data for the redeployed units gathered in 2020 will be compared to the 2019 data modeled to validate the effectiveness of the redeployment.

About the Author

Mike Price is the president of Entrada/San Juan Inc. and was the mining and earth sciences industry manager at Esri between 1997 and 2002. He has been writing tutorials that help ArcUser readers understand and use GIS more intelligently since the magazine’s founding. He is a geologist and has been a volunteer firefighter in Moab, Utah, for many years.

Salisbury University’s M.S. in GISM — now in its 13th year — is designed specifically for the working GIS professional who seeks the management credentials needed for career advancement.

Specialized Program

- Combines management and technical proficiency
- Customized for those in government, business and non-profits
- Earn education credits toward GISP® certification

Convenient and Accessible:

- 100% online
- Earn degree full time in 13 months or part time in 2 years
- Complete coursework on your schedule
- Begin classes summer, fall or spring

Value-Added Education

- Degree frequently leads to substantial salary increases
- Third-party billing options make employer payment easy
- Flat tuition rate, regardless of location

GRE Waived for 2020-21 Enrollment

For more information contact:
Dr. Stuart Hamilton • seh@salisbury.edu

APPY NOW

www.salisbury.edu/msgism
This exercise presents a data development and management workflow that can be applied in all areas of the United States that are covered by the Soil Survey Geographic Database (SSURGO). The development of this methodology grew out of work with staff at Mississippi State University (MSU) in the Precision Agriculture Program. This work showed the need for current, fully attributed soil data at a county level.

The United States Department of Agriculture (USDA) manages SSURGO, one of the world’s largest collections of natural resource soil information. For years, USDA soils were mapped using geopolitical boundaries, often county boundaries. Today, SSURGO soils are typically mapped using the US Geological Survey (USGS) National Hydrography Dataset (NHD) Hydrologic Unit Code (HUC) subbasin boundaries. (To learn more about SSURGO, see the accompanying article, “Too Many Acronyms but Lots of Value.”)

The USDA SSURGO soils data is available for download by watershed area using an ArcGIS Online feature service. For many years, county agricultural service agencies and farmers prepared soil maps for individual counties. Since county boundaries and NHD subbasin boundaries seldom coincide, the first step will be to identify all subbasins within the desired county to create a county map.

In November 2019, ArcGIS Online began hosting a new service that accesses updated SSURGO data by subbasin. This new service will be used to download and model data for Bolivar County, located in western Mississippi, just east of the Mississippi River. This workflow includes:
1. Identifying and acquiring all subbasins and soils that intersect Bolivar County.
2. Clipping SSURGO soils to exact subbasin limits.
3. Merging clipped subbasins for the area that covers the entire county.
4. Clipping the merged basins to the county boundary.
5. Applying a standard USDA thematic soils legend.

This workflow may be applied to any county in the United States for which SSURGO soils data is available. The sample dataset for this exercise includes an enhanced version of the basemap created in the previous exercise in “Making a Precision Reference Map in ArcGIS Pro,” which starts with the MS Ag Reference Map of Bolivar County that was built using vector data downloaded from the Mississippi Automated Resource Information System (MARIS) data site.
in the Fall 2019 issue of ArcUser. Use this copy of the basemap.

Download the sample dataset from esri.com/arcuser and unzip on a local machine. If you have retained the previous exercise dataset, the new dataset for this exercise has been renamed and will not overwrite it.

Start ArcGIS Pro, navigate to MS_AG_Technology, and open MS_AG_SSURGO.aprx. Inspect the MS Ag Reference Map of Bolivar County, which was built using vector data downloaded from the Mississippi Automated Resource Information System (MARIS) data site.

Set World Imagery as the basemap layer. Imagery will highlight the relationships between high-resolution data on soils, natural vegetation, and agricultural use that will be analyzed in this exercise. However, for the next steps, turn the imagery basemap off.

Locating and Accessing SSURGO Services

If not already logged in, log in to your ArcGIS Online account and open the Catalog pane of ArcGIS Pro. Select Portal > Living Atlas. Type “USDA SSURGO” in the Search box. Many SSURGO services are available. Locate the USA Soils Map Units that is a map image layer, which should be near the top of the search results. By aligning this image layer with the World Imagery basemap, you can monitor and verify soil downloads, checking both extent and symbology. Before loading the image layer, hover the cursor over other USA Soils Map Units services, including the feature layer, web map, and a hosted tile layer.

Return to the top of the list, right-click the map image layer, and select Add to Current Map. Position this layer above World Imagery and expand its legend. Look at Table 1: USDA Soil Order Classification System, which provides more information about USDA soil naming conventions.

Make the soils image partially transparent (Appearance tab > Effects > Layer transparency) and compare soils to the underlying aerial imagery. Click this imagery layer to access pop-ups that provide information about specific soils. Use the Bolivar County, MS 1:300,000 bookmark to return to the full Bolivar County extent.

Now, add the SSURGO Downloader Subbasins service. This application provides quick access to ready-to-use map packages filled with useful soil data derived from the SSURGO dataset.

Return to the Catalog pane search, click the All Portal cloud, and type “ssurgo downloader” in the Search box. Locate
Acquiring SSURGO Data for Subbasins

Before downloading any data, set up Environments. Click the Analysis tab and click Environments. Verify that SSURGO_Soils.gdb is set as the Current and Scratch Workspace and that Output Coordinate System is set to WGS_1984_UTM_Zone 15N. Set the Processing Extent to Same As Layer > MARIS Bolivar County Group/Bolivar County. Click OK to update Environments.

The next step is to select all the sub-basins in Bolivar County. On the Map tab, click Select by Location. The Geoprocessing pane opens. Click the Select by Location pane and set SSURGO Downloader Subbasins as the Input Features. Define an Intersect Relationship, set Bolivar County as Selecting Feature, and click Run. The four selected subbasins should be Lower Mississippi-Greenville, Deer-Steele, Big Sunflower, and Lower Mississippi-Helena.

Use the Clip tool to clip the SSURGO subbasin soils using their respective NHD boundary layers.

SSURGO Downloader Subbasins, right-click its name, and select Add And Open. SSURGO Downloader Subbasins will open in a new map, zoomed in to Southern California. Copy this layer into MS Ag Reference Map by right-clicking SSURGO Downloader Subbasins (choose the web map, not the feature layer) and selecting Copy.

Return to MS Ag Reference Map, right-click on its name in the Contents pane, and select Paste. Place the SSURGO Downloader Subbasins layer above the USA Soils Map Units layer (which should be turned off) and open its legend.

Right-click SSURGO Downloader Subbasins and open its attribute table. Save the project. For more information on SSURGO, subbasins, and the SSURGO Subbasins Downloader, read the accompanying article “Too Many Acronyms but Lots of Value.”
In the attribute table, select Show Selected Records, and sort the records in ascending order by SUBBASIN. Highlight and inspect the Big Sunflower record. Carefully study the Subbasin_name and Link fields. You must use the subbasin name when downloading and saving SSURGO data. At the top of the Contents pane, switch to List by Selection and make only SSURGO Downloader Subbasins selectable. On the Map tab, open the Explore icon drop-down and check Selectable Layers. This small step is very important.

Save the project.

To map all Bolivar County soils will require downloading and carefully managing four subbasin datasets. This is the process you will use for each subbasin.

Select the Explore tool and left-click inside Big Sunflower, the large highlighted subbasin that covers much of the state.

Study the Big Sunflower pop-up. The information in the pop-up indicates that there are two ways to capture soils data: either as a Download project package or as a Map package. Since the Download project package accesses newer data, choose it.

Left-click the Download link. Your default browser will open. Choose to open BigSunflower_08030207 ArcGIS Pro. A new ArcGIS Pro project named BigSunflower_08030207 opens over your current ArcGIS Pro project.

Zoom to the Subbasin layer.

This entire map will be copied into the MS_AG_SSURGO project, but three items in this new project must be renamed first. In the Contents pane, change the names of the following layers by right-clicking and accessing Properties.

Rename the map to BigSunflower, rename Subbasin to NHD BigSunflower, and rename Mapunits to SSURGO BigSunflower. Type these names exactly as shown. Use only alpha characters in the subbasin name, and don’t use hyphens.

Save the project.

After renaming those three items, open the Catalog pane in the new project and expand Maps. Highlight BigSunflower, right-click it, and select Copy. Return to the MS Ag Reference Map project and in the Catalog pane, expand Maps, right-click it, and select Paste.

NHD and SSURGO layers need to be copied into MS Ag Reference Map. Starting with BigSunflower, select both NHD and SSURGO layers, right-click, and select Copy. Return to MS Ag Reference Map, right-click its title (MS Ag Reference Map) and select Paste. Save the MS_AG_SSURGO project.

Close the BigSunflower_08030207 ArcGIS project.

Return to MS Ag Reference Map. For three other subbasins—DeereSteele, LowerMississippiGreenville, and LowerMississippiHelena—repeat the previous process (select; download; extract; rename Map, Subbasin, and Mapunits with the subbasin name; copy the map in the new ArcGIS project; and paste into MS Ag Reference Map. Then copy the NHD and SSURGO layers and paste into the MS_AG_SSURGO project. Save the project after adding the map and layers for each subbasin.

Managing Maps

When you have finished downloading and copying over all four subbasins, reorder the layers with NHD layers first and then all
<table>
<thead>
<tr>
<th>Soil Order</th>
<th>Soil Order Description</th>
<th>Percent of Global Coverage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alfisol</td>
<td>Soils with aluminum and iron. Alfisols have horizons* of clay accumulation, and form where there is enough moisture and warmth for at least three months of plant growth.</td>
<td>10</td>
</tr>
<tr>
<td>Andisol</td>
<td>Volcanic ash soils. Andisols are young and very fertile.</td>
<td>1</td>
</tr>
<tr>
<td>Aridisol</td>
<td>Dry soils forming under desert conditions. Aridisols are climates that have fewer than 90 consecutive days of moisture during the growing season and are nonleached. Soil formation is slow, and accumulated organic matter is scarce. Many aridisols have well-developed B horizons showing clay movement from past periods of greater moisture.</td>
<td>12</td>
</tr>
<tr>
<td>Entisol</td>
<td>Recently formed soils that lack well-developed horizons. Entisols are commonly found on unconsolidated river and beach sediments of sand and clay or volcanic ash. Some entisols have an A horizon on top of bedrock.</td>
<td>18</td>
</tr>
<tr>
<td>Gelisol</td>
<td>Permafrost soils with permafrost within two meters of the surface or gelic (frost churned) materials and permafrost within one meter.</td>
<td>9</td>
</tr>
<tr>
<td>Histosol</td>
<td>Organic soils. Histosols were formerly called bog soils.</td>
<td>1</td>
</tr>
<tr>
<td>Inceptisol</td>
<td>Young soils. Inceptisols have subsurface horizon formation but show little eluviation and illuviation (dissolved minerals transported up or down by groundwater).</td>
<td>15</td>
</tr>
<tr>
<td>Mollisol</td>
<td>Soft, deep, dark fertile soil formed in grasslands and some hardwood forests. Mollisols have very thick A horizons.</td>
<td>7</td>
</tr>
<tr>
<td>Oxisol</td>
<td>Heavily weathered soil. Oxisols are rich in iron and aluminum oxides or kaolin but low in silica.</td>
<td>8</td>
</tr>
<tr>
<td>Spodosol</td>
<td>Acid soils with an organic colloidal layer with complexes iron and aluminum leached from a layer above. Spodosols are typical soils of coniferous and deciduous forests in cooler climates.</td>
<td>4</td>
</tr>
<tr>
<td>Ultisol</td>
<td>Acid soils in the humid tropics and subtropics. Ultisols are depleted in important plant nutrients, including calcium, magnesium, and potassium. Ultisols are highly weathered, but not as weathered as oxisols.</td>
<td>8</td>
</tr>
<tr>
<td>Vertisol</td>
<td>Inverted soils. Vertisols are clay-rich and tend to swell when wet and shrink upon drying, often forming deep cracks into which surface layers can fall.</td>
<td>2</td>
</tr>
</tbody>
</table>

* Horizons are the layers in soil. The A horizon is the soil surface. The B horizon is the subsoil.


SSURGO Geoprocessing

If you carefully study each downloaded subbasin, you will likely see soil polygons that extend outside NHD subbasin boundaries. Merging the raw subbasin data would likely create overlap polygons along basin margins that would distort the resulting merged soils. For example, areal statistics...
by soil and acreage type would be rather inaccurate. To resolve this issue, clip and save only soils within a subbasin perimeter.

Before starting, clean up the project by removing all SSURGO maps (BigSunflower, DeerSteele, LowerMississippiGreenville, and LowerMississippiHelena) from the MS_AG_SSURGO ArcGIS project. Only MS Ag Reference Map and SSURGO Downloader Subbasins will remain. In the SSURGO Import Group layer, make NDH BigSunflower and SSURGO BigSunflower visible and make sure all other layers are turned off. Save the project.

In this step, the four soil datasets will be clipped to their NHD subbasin boundary. Open the Geoprocessing pane and type “clip” in the search area. Select Clip from the Analysis Tools. Set Input Features as SSURGO BigSunflower, set NHD BigSunflower as Clip Features, and SSURGO_BigSunflower_Clip as the Output Feature Class and store it in MS_AG_Technology\MS_AG_Technology\SSURGO\SSURGO.gdb. Make sure the output feature class name is exactly SSURGO_BigSunflower_Clip, using underscores and no spaces. Remember that carefully using consistent naming conventions is critical. Click Run to execute the Clip tool. The SSURGO_BigSunflower_Clip layer will load at the top of the Contents pane. Turn the new layer off.

Clip the remaining three SSURGO subbasin soils, using their respective NHD boundary layers, using the same procedure. Carefully name all output feature classes using the above procedure and assigning names with this format: SSURGO_<subbasin name>_Clip.

When finished, group all four clipped subbasins in a group layer called SSURGO Clip Group. Notice that the Environments Extent setting has limited all clipped soils to the boundary for Bolivar County.

Merging Clipped Subbasins
With all four subbasins clipped to their respective NHD boundaries, they can be merged into a single countywide polygon feature class. Since the SSURGO table structure is consistent across all US subbasin datasets, the extensive attribution for each dataset will be preserved. These merged subbasin datasets can then be clipped to the Bolivar County boundary.

Open the Geoprocessing pane and search for “merge” and choose Merge (Data Management Tools). Click the down arrow next to Input Datasets to add many datasets. Check the boxes next to all four clipped subbasins in the SSURGO Clip Group and click Add to add them. Set the Output Dataset path as MS_AG_Technology\MS_AG_Technology\SSURGO\SSURGO.gdb and name it SSURGO_Bolivar_Merge_Raw. Verify that Merge Rule is set to First and all SSURGO Clip Group\ parameters are set to areasymbol. Click Run to merge four soil sets. Once merged, inspect the SSURGO_Bolivar_Merge_Raw, place it in the SSURGO Clip Group, and save the project.

Clipping Merged Subbasins
Next, clip the merged SSURGO subbasins to the Bolivar County boundary. Reopen the Geoprocessing Clip tool and set SSURGO_Bolivar_Merge_Raw as Input Features. Set Clip Features to Bolivar County, then set Output Feature Class as MS_AG_Technology\MS_AG_Technology\SSURGO\SSURGO.gdb and name the output feature class SSURGO_Bolivar_Final_Clip. Click Run to perform the clip. When the clipped layer loads in the Contents pane, inspect it for accuracy and completeness. Move it to the top of the SSURGO Clip Group and save the project again.

Symbolizing and Studying SSURGO Soils
Display the original USA Soils Map Units image and inspect its thematic legend. The SSURGO type names and thematic colors are assigned by an attribute named Esri Symbology. To replicate this symbology, borrow this legend from one of the ArcGIS Online maps that were downloaded earlier in a previous step in this exercise. However, there is no guarantee that the legend for an individual subbasin would include all mapped soil types. This would be especially true if soils were downloaded from another region.

Go to the bottom of the Contents pane and make the USA Soils Map Units image visible. To standardize thematic mapping, let’s use the layer file legend I created that will properly display downloaded SSURGO soil polygons from any location in the continental United States. After using this layer file to symbolize soils, compare them to the Soils Map image.
To apply this layer file, right-click SSURGO_Bolivar_Final_Clip in the Contents pane and select Symbology. In the Symbology pane, left-click the Symbology menu tool (i.e., the three bars in the upper right corner) and select Import symbology. The Apply Symbology From Layer geoprocessing tool opens. Click the folder next to the Symbology layer and navigate to \MS_AG_Technology\MS_AG_Technology\SSURGO and locate USA Soils Map Units.lyrx. Add this file to the tool and specify esrisymbology as the Source Field and Esri Symbology as the Target Field. Click Run. This will apply standardized SSURGO symbology to SSURGO_Bolivar_Final_Clip. Inspect the resymbolized Bolivar SSURGO layer. Inspect the polygon symbols assigned to soil types. Close the Symbology pane and save the project.

Updating and Inspecting Bolivar County SSURGO Soils

To complete this project, update the clipped soils and save a layer file that can load the symbolized feature class into any ArcGIS Pro map. In the Contents pane, rename SSURGO_Bolivar_Final_Clip to SSURGO Bolivar Co, MS Soils. Right-click the renamed soils and select Sharing, then Save as Layer File. Navigate to the SSURGO folder and save the new .lyrx file next to USA Soils Map Units.lyrx.

Move the MARIS Bolivar County Group above SSURGO Bolivar Co, MS Soils and turn on all layers except PLSS Sections and Populated Places. Zoom to a 1:250,000 scale. In the MARIS Bolivar County Group, right-click Towns and turn on Labels. Use Find to locate the town of Symonds. Adjust the map scale to also see Clifford to the southeast. Open the attribute table for SSURGO Bolivar Co, MS Soils. Choose Select > Rectangle to select a small area between Symonds and Clifford. Show only selected records and click individual records to highlight them on the map.

Scroll to the right in this very wide attribute table to learn what soil types and conditions contribute to prime farmland. By looking at the attribute field Farmland Class, you can identify arable land and land categorized as not prime farmland. Look for attributes on flooding potential, clay content, poor drainage, runoff character, and other factors.

Inceptisols represent high clay areas and often include old river meander features. These are the soils to avoid. Use your creative mapping skills and tools such as Select...
Hands On

The United States Department of Agriculture (USDA) Natural Resources Conservation Service (NRCS) produces and manages one of the world’s largest collections of natural resource information. The Soil Survey Geographic Database (SSURGO) contains data with hundreds of soil attributes in over 70 tables and includes more than 36 million mapped features. SSURGO represents over 100 years of work by many soil scientists. The database contains information ranging from the chemical and physical properties of soils to derived interpretations used in engineering, natural resource management, disaster response, climate science, and economic modeling.

NHD HUC 8 Subbasins
SSURGO soils are often mapped using topography and geopolitical boundaries. For years, the agencies within USDA mapped and maintained soil databases, often available at a county level. Today, SSURGO soils are typically mapped within US Geological Survey’s (USGS) National Hydrography Dataset (NHD) and its companion Watershed Boundary Dataset (WBD). The WBD assigns numeric hydrologic unit codes (HUC) to identify unique basins. Watershed and Subwatershed hydrologic unit boundaries (WSB) provide a uniquely identified and uniform method of subdividing large drainage areas.

SSURGO soils are mapped and displayed within the limits of HUC 8 subbasins, often at a 1:24,000 scale. HUC 8 subbasins vary in size and are typically less than 250,000 acres, or about 400 square miles in size. Each HUC 8 subbasin is uniquely identified by an eight-digit naming code. HUC 8 subbasins are a subset of HUC 6 basins and include multiple HUC 10 subbasins. HUC 8 subbasins support applications and programs of many local, state, and federal agencies.

A New SSURGO Service
In November 2019, Esri updated the ArcGIS Online SSURGO mapping and data download service. The new service, produced by Esri’s ArcGIS Living Atlas environment team, helps mappers locate and download SSURGO soils supported by the NRCS 2019 data snapshot.

The updated service includes 18 new agriculture-related fields to the feature layer and map image layer. The attribute tables now include estimates of yield for four major crops (corn, cotton, soybeans, and wheat). Values for irrigated and nonirrigated farming systems are provided in units of bushels per acre or, in the case of cotton, pounds per acre. Attributes are linked directly to soil polygons, so additional table joins may not be needed.

Five new fields access the National Commodity Crop Productivity Index (NCCPI) Version 3. The NCCPI provides a standardized value for the entire nation and allows comparisons between regions. The NCCPI ranks soils on a scale of 0–1, with larger values indicating more productive soils. The five new fields provide NCCPI values for corn, soybeans, cotton, and small grains and an overall value. This new data supports soil-based economic models, yield modeling, and crop productivity forecasts.

Too Many Acronyms but Lots of Value

By Mike Price

The United States Department of Agriculture (USDA) Natural Resources Conservation Service (NRCS) produces and manages one of the world’s largest collections of natural resource information. The Soil Survey Geographic Database (SSURGO) contains data with hundreds of soil attributes in over 70 tables and includes more than 36 million mapped features. SSURGO represents over 100 years of work by many soil scientists. The database contains information ranging from the chemical and physical properties of soils to derived interpretations used in engineering, natural resource management, disaster response, climate science, and economic modeling.

A New SSURGO Service
In November 2019, Esri updated the ArcGIS Online SSURGO mapping and data download service. The new service, produced by Esri’s ArcGIS Living Atlas environment team, helps mappers locate and download SSURGO soils supported by the NRCS 2019 data snapshot.

The updated service includes 18 new agriculture-related fields to the feature layer and map image layer. The attribute tables now include estimates of yield for four major crops (corn, cotton, soybeans, and wheat). Values for irrigated and nonirrigated farming systems are provided in units of bushels per acre or, in the case of cotton, pounds per acre. Attributes are linked directly to soil polygons, so additional table joins may not be needed.

Five new fields access the National Commodity Crop Productivity Index (NCCPI) Version 3. The NCCPI provides a standardized value for the entire nation and allows comparisons between regions. The NCCPI ranks soils on a scale of 0–1, with larger values indicating more productive soils. The five new fields provide NCCPI values for corn, soybeans, cotton, and small grains and an overall value. This new data supports soil-based economic models, yield modeling, and crop productivity forecasts.

Summary and Acknowledgments
This is a rather challenging and very real-world exercise. I’ve had fun exploring soils at my family’s properties—past and current—that are scattered across the west. Hopefully, you enjoy this search and interpretation and have become quite skilled at data downloads from ArcGIS Online, geoprocessing, and file management.

Thanks to the fine staff members of the MSU Precision Agriculture Program for their encouragement as I developed this exercise. Special thanks to Dr. Amelia A. Fox, who happens to be my youngest sister and a very dedicated Skagit County, Washington, farmer who has been transplanted to the fine state of Mississippi.

Thanks, too, to the US Department of Agriculture and Esri staff who worked on the development and deployment of ArcGIS Online SSURGO soils, for all their fine efforts and for encouraging me to tackle this complex workflow.

About the Author
Mike Price is the president of Entrada/San Juan Inc. and was the mining and earth sciences industry manager at Esri between 1997 and 2002. He has been writing tutorials that help ArcUser readers understand and use GIS more intelligently since the magazine’s founding. He is a geologist and has been a volunteer firefighter in Moab, Utah, for many years.
This tutorial finishes the map with layout text. This is the easiest part. It’s the graphic text on your final map that isn’t associated with data layers, such as the title, credits, legends, scale bar, and descriptive paragraphs.

In the Darwin project, click the Layout tab. This layout has two maps. Map Frame 1 is the main map of the Darwin region. Map Frame 2 is the key map of Australia that floats transparently on the upper left side of the main map.

Normally, the first thing I’d do is add a title, but I think that this map is self-explanatory. The title would just say Darwin, Australia, which is already displayed prominently via labels. The first rule of map layouts is to not add anything that isn’t necessary.

I do want to add some text to the key map. I’m worried that it’s not clear that the little box sitting on top of Australia represents the area of the main map. On the ribbon, click the Insert tab, which contains anything that you want to add to a layout, from photos to graticules.
Hands On

If you drag either of the maps around, you’ll find that the map area text stays in place on the page, while all the other text moves with the map. That’s what makes layout text different from labels and annotation. It belongs to the layout, not the map.

There is some other text on the layout already. It’s the credits for the imagery basemap. And wow, is it hard to read. But don’t worry, you can change this text into something that matches the formatting of the rest of the map.

On the ribbon, click the Insert tab and click Dynamic Text. Scroll down in the menu and choose Service Layer Credits. Draw a rectangle on the map where you’d like the credits to go. The text disappears from the bottom of your map and reappears in your chosen spot. Although you can’t change how the text reads, you can change how it appears.

Double-click Text1 in the Contents pane to open the Format Text pane. Click Text Symbol > Properties > and Appearance to update font properties to match the text for the key map you just placed with the size set to 6 pt.

But you need to cite data sources in addition to those for the basemap. In the Format Text pane, choose Text > Options. Inside the text editing box, there is a tag for the existing dynamic text (serviceLayerCredits). Place your cursor in front of the dynamic text and add text to identify the area of the main map. Format and place the Service Layer Credits to make them more legible. Access the Service Layer Credits via dynamic text. Use Format Text and tags to reformat the Service Layer Credits and include additional credits.

In the Text section, click the New Rectangle Paragraph button. Drag a rectangle on the layout near the keymap locator box and type the text “map area”. If necessary, double-click the Text element in the Contents pane to open the Format Text pane so you can adjust the Text Symbol properties to match the rest of the map. Click Text Symbol > Properties, and under Appearance, choose Century Gothic, Bold, and 7 pt. Choose white for the text fill symbol and color and no color for Outline color. Click Apply.
Feature Data Source: Commonwealth of Australia (Geoscience Australia) and Natural Earth (naturalearthdata.com) Imagery

If you like, you can also add Cartography: <Your Name>, <Date>
You can also add text formatting tags to make this block of text easier to read. I used <BOL></BOL> to bold some words.

Next, you can add a scale bar. On the Insert tab of the ribbon, click the bottom part of the Scale Bar button. Choose Single Division Scale Bar from the Metric list. Drag a rectangle on the layout to add your new scale bar.

Tip: If your scale bar says something like 2,000 kilometers, it’s referring to the key map instead of the main map. You can fix this problem in the Format Scale Bar pane by changing the Map frame to Map Frame 1.

On the ribbon, experiment with the options on the Format and Design tabs to customize the scale bar until it looks just the way you like. You can refer to the Finished Layout tab to see the settings I used. You can add a north arrow in the same way.

And there it is—a finished map—with label classes converted into annotation, enhanced with masks, and topped off with a bit of graphic layout text.

If you’ve been intimidated by map text in the past, I hope that you can now move forward with confidence and build some truly beautifully labeled maps! Remember that conventions aren’t rules, compromises will have to be made, and research can be fun.

About the Author
Heather Smith is a cartographer and artist who mixes both practices to express and understand landscapes. She works as a product engineer at Esri, where she writes and edits lessons for the Learn ArcGIS website. View more of her work at www.heathergabrielsmith.ca.
There’s a lot in a name.

Just ask any expectant parent trying to decide on a name for their child. Names are important—not just for people but for the attribute fields in your layers.

What’s a Naming Convention?
I think of field names the same way I do about complex words in English. They have a prefix, a root, and a suffix. Even if you’ve never heard the word acrophobia before, you might be able to figure out its meaning by realizing that acro is a root that means height (think acrobat), and phobia is a suffix that means fear. In this case, fear of heights.

Prefixes and suffixes in field names help communicate the meaning of the data in your field in a similar way. For example, for binary variables, which are variables that can only be yes or no (1 or 0), I often use the prefix is or the suffix _flag. Here are some examples:

- isVeteran or veteran_flag
- isTeachingHospital or teaching_flag

When categorizing a continuous variable such as age, or minutes spent commuting, I tend to use my own personal shorthand of LT, LE, GT, and GE.

LT for less than (e.g., LT18 means less than age 18).
LE for less than or equal to (e.g., LE5 means a commute time of 5 minutes or less).
GT for greater than (e.g., GT60 means a commute time of more than an hour).
GE for greater than or equal to (e.g., GE65 means age 65 and over).

Wrong!

As you create more layers, you’ll undoubtedly come up with your own consistent naming conventions that make sense for your data needs. The key word is consistency.

Lastly, pick a format—camelCaseVariableNames or underscore_variable_names—and stick to it. Maybe you do an underscore after some ID number but camel case for the rest. It’s a personal preference, but consistency is valued.

If you are building a layer that others on your team will use at some point or that you might use several months from now, do yourself a favor and spend minutes now that will save you hours later. Good field names also help coworkers get up to speed quickly when collaborating. Naming conventions help when layers have dozens or even hundreds of related attributes, and you need to be able to make sure you’re using the right one for the right purpose.

How Does This Really Work?
the prefix is the units of wage ("h" for hourly or "a" for annual), the root is the value itself (e.g., median), and the suffix is the detailed occupational category from the Bureau of Labor Statistics Standard Occupational Classification (BLS SOC). For example, the field called h_median_499051 is the median hourly wage of workers with BLS SOC number 49-9051, which happens to be wind turbine service technicians.

Convey Information about the Original Source
This energy workers employment and wage layer was originally a series of spreadsheets from the Bureau of Labor Statistics that contained all kinds of metadata. My field names let me provide the exact identifier of the occupation classifications, which makes the value my field is storing unambiguous.

Allow Other Analysts to Work with Layer Data Quickly
Anyone applying any kind of SQL logic when using your layer will thank you for using a consistent naming convention. Consistent field names make it easy for programmers to do systematic data transformations. For example, if all hourly wage fields start with an "h," programmers can multiply these fields by 40 to get an approximate weekly wage.

Display Aliases Communicate What Your Fields Are
My attribute field named h_median_499051 is the hourly median wage for wind turbine service technicians. ArcGIS Online allows you to give your fields display aliases that communicate this information using natural language. Aliases bring explanations into the layer in a user-friendly way.

Aliases are much more accommodating than field names because they allow up to 255 characters. This lets you use a complete phrase to describe the field. That is usually enough room to spell out acronyms and abbreviations, so please do. Unlike field names, aliases can begin with numbers and contain spaces and special characters.

ArcGIS Online Uses Aliases throughout the Product
ArcGIS Online rewards you when your layers have aliases by using them throughout the whole product. Aliases are visible in the auto-generated legend for the attribute you’re mapping. When I map the
ArcGIS Online rewards you for providing aliases for field names by using them throughout the product: in the legend, in pop-ups, and in field headers for attribute tables.

Hands On

Hands On

Many Ways to Apply Aliases to Layers

If you are publishing a web layer from ArcGIS Pro, all aliases on your feature class will be transferred. This also adds aliases permanently to their source file in the geodatabase.

In ArcGIS Online, you can apply aliases within the Map Viewer using Configure Pop-up > Configure Attributes. This is also where you can toggle the display of fields in your attribute table on and off, change the order in which fields display in the attribute table, and format fields (e.g., number of decimal places shown or use of comma separators for thousands).

In ArcGIS Online, on the Data tab of the item details page, you can add long field descriptions, which lets you move the data’s documentation closer to the GIS analysts who will be using your layer.

You can also change aliases on a hosted feature service using the Feature Service Alias Updater tool (https://bit.ly/2VpTuag) written by my colleague Lisa Berry and available at no charge. I use it so often I have added it to My Favorites in ArcGIS Online. It’s great for doing bulk updates to a layer with dozens of fields.

The Initial Effort Pays Off

Next time you publish a layer, help your future self out and anyone else who will use the layer by constructing consistent field names and descriptive aliases. The payoff is well worth the initial time. You won’t have to remember what you were thinking months ago or constantly refer to a codebook. It will help other analysts in your organization who will work with your layer and those who will be viewing your maps by making the legend easy to read.

If you publicly share your consistently named and well aliased layer with ArcGIS Online users worldwide or nominate it for inclusion in the ArcGIS Living Atlas of the World, you will be building trust and credibility in this layer and in yourself as a professional GIS content creator.
Learn to Use ArcGIS QuickCapture

By Bern Szukalski and Kathryn Keranen

The field data collection app ArcGIS QuickCapture was designed to support field teams that need to rapidly collect data from a moving vehicle, helicopter, bicycle, or all-terrain vehicle (ATV). It has a simple, form-based interface and is an excellent choice for collecting almost any type of data. You can capture both the location and attributes of assets or incidents as you travel.

You create the form, determining the arrangement, appearance, and color of buttons and the information collected. That information can include photos and sensor information from a device.

This exercise introduces you to QuickCapture. You will create a simple QuickCapture form that will let students capture photographs and locations of the things they might see around a school campus. You will create and configure a feature layer, make a QuickCapture project and form, collect data, and view collected data.

Create a Feature Layer

QuickCapture data is captured and saved to a feature layer. Feature layers can be created in many ways—from a template, from an existing layer, from a URL pointing to an existing service, or from scratch. For this simple example, you can use ArcGIS Online to create a feature layer from scratch provided you have privileges that allow you to create hosted feature layers.

Begin by signing in to your ArcGIS Online organizational account. In the Content tab, click Create, then choose Feature Layer. In the From Template tab, choose Build a layer, then select Points. Click Create.

Click Point layer to change the name of the feature layer to Campus Capture. Click Next when finished.

Set the extent to where you want to collect your data using the map and then click Next. Add Campus Capture as the title and tags and a summary for this new hosted feature layer item. Click Done when finished.

It’s a best practice to complete the item details page for the hosted feature layer you just created, so do that and add a well-crafted thumbnail and a detailed description and set Delete Protection in the Settings tab.

Configure the Feature Layer

Next, configure the attribute fields to capture the information you desire. In this example, you will make a list of values to capture. Open the Data tab for the feature layer item and click Fields and then click Add. For Field Name and Display Name, type "Capture". Make the type String, shorten the length to 25 characters, and uncheck Allow Null Values. Click Add New Field.

Scroll down the list of fields and click Capture, the field you just created. Click Create List. Type "Big Tree" for Label and "Big Tree" for Code. Repeat this process to add fields for Small Tree, Shrub, Rock, Sign, Light, Art, People, Animal, and Car, clicking Add or pressing Enter after each pair. Click Save when all fields have been added. The Code can be different than the Label, but for this example they are both the same.

To symbolize the values with a unique color rather than displaying all values with a single color, click the Visualization tab. Click the Change Style button to edit the layer style. From the drop-down, select the attribute you want to symbolize. In this case, the attribute will be Capture. Change the symbols by clicking Options and editing the symbols as you desire. When you are finished, click OK, then Done. Click Save Layer to save all your changes.

You can modify the app’s look and functionality with ArcGIS QuickCapture designer.
Create the Project in QuickCapture Designer
In ArcGIS Online, use the App Launcher (located next to your avatar) to open QuickCapture designer. Click New Project. Choose Campus Capture and click Next. Confirm the project information, make any necessary edits, then click Create.

You can modify the look and feel of the app with QuickCapture designer. With the QuickCapture designer, you can change properties for individual buttons or an entire group as well as choose a variety of other settings and options.

Click the group label (Campus Capture) to apply changes to the entire button group. When selected, the group will be outlined in orange. In the group properties, set the number of columns to 2.

Press the Shift key and click to select all the buttons. Selected buttons will be outlined in orange. With all buttons selected, open the Appearance tab and choose the large button size. Click the Data tab and enable photos by sliding the button. Save the project. Click Share to make the project available to all members of your organization.

Note: When you click Save, a dialog appears from which a QR Code to open the project can be captured. The QR Code can also be obtained from the Sharing dialog, which also includes a link to the project. The QR code is handy if you have the device in hand, or the link can be emailed to members to open the project.

Open the Project in the QuickCapture App
Install the QuickCapture mobile app from the Apple or Google Play app store onto your device. Once it is installed, open the QuickCapture mobile app and sign in. Alternatively, you can open the link or QR Code to present the sign in page immediately.

If prompted, allow QuickCapture to access your location so your device’s location will be used when capturing attributes. Open the project and tap Get Projects to view available projects. Download the Campus Capture project and click the project icon to open it.

When collecting data, tap the appropriate button to capture that feature. The camera will open, so you can take a photo. When you finish, the location and photo will be stored in the feature layer, along with the date and your account name as the QuickCapture user.

View Your Results
Go to ArcGIS Online and under your Contents, locate Campus Capture and click the thumbnail to open it in Map Viewer. You can also view results by opening the QuickCapture designer, hovering over the project, and clicking View Results, or you can open the feature layer in a web map.

Open this Campus Capture map (https://bit.ly/2Y9l4Kf) created for this exercise. Click on a feature and note its attachments. You can use the Attachment Viewer configurable app template to view photos and videos stored as feature attachments, making the app well suited for use with maps made using QuickCapture.

You can do a lot more with ArcGIS QuickCapture than this simple project. You can capture data for multiple feature layers, as well as line and polygon feature types. QuickCapture designer lets you add images to buttons, specify horizontal accuracy, and edit the project’s JSON.

Currently, ArcGIS QuickCapture requires a named user to open a project in the mobile app. Support for public QuickCapture projects is planned.

About the Authors
Bern Szukalski is a tech evangelist and product strategist at Esri, focusing on ways to broaden access to geographic information and helping users succeed with the ArcGIS platform. On a good day, he is making a map; on a great day, he is on one.

Kathryn Keranen is an award-winning teacher and author. She serves as an instructor in geographic science at James Madison University and is the cofounder of the award-winning Geospatial Semester. With Bob Kolvoord, she is the coauthor of the Making Spatial Decisions series published by Esri Press.
Add Hand-Drawn Charm to Your Maps

By Warren Davison

As a GIS analyst for the City of Waterloo, Ontario, in Canada, I get to work with amazing teams doing GIS analysis, creating maps, and sharing technical and creative resources. If you visit my website (warrenrdavison.wixsite.com/maps), you might notice that I am especially fond of maps that have a hand-drawn, tactile charm. Why should maps be sterile?

As a civic geographer (a GIS analyst who works for a municipal-ity), I often see the renderings of landscape architects and architectural draftspeople. I admire the hand-drawn, artistic quality that they bring to their work. They fluently render worlds that don’t quite exist yet—plans and ideas—so a sketched and painted approach is totally appropriate and beautiful. I have felt drawn to them myself. I have seen requests from GIS users for symbols that replicate typical landscape, site plan, and architectural drawings stylistically while providing some cartographic flair and sketchy imprecision for their spatial data.

So, I opened a project in ArcGIS Pro and began creating point, line, and polygon symbols that echo a hand-drafted aesthetic. When I was happy that the features I was symbolizing looked convincingly landscaped, I saved them to a style that I had created. In ArcGIS Pro, a style, is a collection of saved symbols that can be easily reused within all your projects and shared with your team or anyone in the ArcGIS Pro user community. The graphic capabilities of ArcGIS Pro enable some amazing—and even convincingly realistic-looking—symbology. Anyone can make styles. If you can apply symbology, you can create a style. I named this style Draft Sketch.

I opened a project in ArcGIS Pro and began creating point, line, and polygon symbols that echo a hand-drafted aesthetic. When I was happy that the features I was symbolizing looked convincingly landscaped, I saved them to a style that I had created. In ArcGIS Pro, a style, is a collection of saved symbols that can be easily reused within all your projects and shared with your team or anyone in the ArcGIS Pro user community. The graphic capabilities of ArcGIS Pro enable some amazing—and even convincingly realistic-looking—symbology. Anyone can make styles. If you can apply symbology, you can create a style. I named this style Draft Sketch.

The Draft Sketch style includes must-have items for landscape drawings like a fountain polygon. Warren Davison’s Draft Sketch style contains symbols that replicate typical landscape, site plan, and architectural drawings stylistically.

As a GIS analyst for the City of Waterloo, Ontario, in Canada, I get to work with amazing teams doing GIS analysis, creating maps, and sharing technical and creative resources. If you visit my website (warrenrdavison.wixsite.com/maps), you might notice that I am especially fond of maps that have a hand-drawn, tactile charm. Why should maps be sterile?

As a civic geographer (a GIS analyst who works for a municipal-ity), I often see the renderings of landscape architects and architectural draftspeople. I admire the hand-drawn, artistic quality that they bring to their work. They fluently render worlds that don’t quite exist yet—plans and ideas—so a sketched and painted approach is totally appropriate and beautiful. I have felt drawn to them myself. I have seen requests from GIS users for symbols that replicate typical landscape, site plan, and architectural drawings stylistically while providing some cartographic flair and sketchy imprecision for their spatial data.

So, I opened a project in ArcGIS Pro and began creating point, line, and polygon symbols that echo a hand-drafted aesthetic. When I was happy that the features I was symbolizing looked convincingly landscaped, I saved them to a style that I had created. In ArcGIS Pro, a style, is a collection of saved symbols that can be easily reused within all your projects and shared with your team or anyone in the ArcGIS Pro user community. The graphic capabilities of ArcGIS Pro enable some amazing—and even convincingly realistic-looking—symbology. Anyone can make styles. If you can apply symbology, you can create a style. I named this style Draft Sketch.

I opened a project in ArcGIS Pro and began creating point, line, and polygon symbols that echo a hand-drafted aesthetic. When I was happy that the features I was symbolizing looked convincingly landscaped, I saved them to a style that I had created. In ArcGIS Pro, a style, is a collection of saved symbols that can be easily reused within all your projects and shared with your team or anyone in the ArcGIS Pro user community. The graphic capabilities of ArcGIS Pro enable some amazing—and even convincingly realistic-looking—symbology. Anyone can make styles. If you can apply symbology, you can create a style. I named this style Draft Sketch.

So, I opened a project in ArcGIS Pro and began creating point, line, and polygon symbols that echo a hand-drafted aesthetic. When I was happy that the features I was symbolizing looked convincingly landscaped, I saved them to a style that I had created. In ArcGIS Pro, a style, is a collection of saved symbols that can be easily reused within all your projects and shared with your team or anyone in the ArcGIS Pro user community. The graphic capabilities of ArcGIS Pro enable some amazing—and even convincingly realistic-looking—symbology. Anyone can make styles. If you can apply symbology, you can create a style. I named this style Draft Sketch.
Python Scripting for ArcGIS Pro

By Paul A. Zandbergen

If you are a GIS professional but not a programmer, there is reason to learn Python scripting. Often you must perform the same workflow in GIS periodically for maintenance purposes or to create data. Automating tasks will help you be more productive. Writing a script will save time, avoid errors, and eliminate tedium.

Python Scripting for ArcGIS Pro, a new book from Esri Press, will help you gain the proficiency you need to benefit from Python scripting even if you are new to programming. It is an easy-to-follow guide to writing Python code with spatial data in ArcGIS Pro.

The book starts with the fundamentals of Python programming and then dives into how to write useful Python scripts that work with spatial data in ArcGIS Pro. Readers learn how to execute the tools in Python, describe data, and manipulate and create data in addition to a number of more specialized tasks. Some of the key topics covered include the following:

• Automating geoprocessing tasks
• Exploring and manipulating spatial and tabular data
• Working with geometries and rasters
• Scripting maps
• Debugging and error handling
• Creating functions and classes
• Making and sharing script tools
• Using ArcPy and ArcGIS API for Python


Women and GIS: Stars of Spatial Science, Volume 2

By Esri Press
Foreword by Jane Goodall

In Women and GIS: Stars of Spatial Science, Volume 2, readers will find the true and inspiring stories of 30 remarkable women who aimed for the stars and created a better world. As science, technology, engineering, and mathematics (STEM) disciplines continue to advance and shape people’s understanding of the world, so, too, do women who take charge and use new research and methodologies to make big changes. From planetary scientists and civil engineers to entrepreneurs and urban planners, the strong, passionate women in this diverse group of women profiled in the second volume of the Women and GIS series used a combination of maps, analysis, and GIS to overcome obstacles and challenges and become leaders in STEM. April 2020, 250 pp. E-book ISBN: 9781589485952 and paperback ISBN: 9781589485945.
Whether it’s fighting crime, improving public health, or fixing potholes, measuring and managing performance are part of the governing philosophy of former Maryland governor Martin O’Malley. Mapping data on these types of issues using GIS has been one of the core techniques he has used to do it.

Data and Maps Tell the Stories
As a mayor and later as a governor, O’Malley instituted a series of performance measurement and management systems—known as Stat systems—for policing, public works, education, business and economic development, health, and the environment. Maps were a key component of those systems.

The implementation of the Stat systems was considered one of O’Malley’s signature accomplishments during his two terms as the mayor of Baltimore from 1999 to 2007 and two terms as the governor of Maryland from 2007 to 2015. These systems incorporated ArcGIS technology, and the maps created using ArcGIS were used within government to gain insights into problems ranging from crimes such as homicides and robberies to environmental issues such as water pollution and lead poisoning. The maps also were used to measure a wide variety of concerns including infant mortality, drug overdose deaths, and land preservation.

O’Malley believes that data, when mapped, can clearly show people the extent of problems or measure
portion of the subway that led to pretty dramatic reductions in crime,” O’Malley recalled. “He started making, using just Magic Markers and paper, maps of where the crime was happening in real time in his portion of the subway. He called his Magic Marker on paper maps ‘Charts of the Future.’ He deployed officers to where he knew, based on the past, the purse snatchings and other sorts of crimes were most likely to happen.” This was a rough but early form of predictive policing.

Eventually Maple wound up at a software convention in Manhattan, saw a demonstration of ArcView GIS, a precursor to ArcGIS, and had the NYPD start using the software to plot crimes on a digital map. A television show called The District, which ran from 2000 to 2004, featured Maple’s computer crime mapping system.

In Baltimore, the O’Malley administration hired Maple as a consultant and launched CitiStat, its own version of CompStat, to monitor and map crimes such as homicides, robberies, and drug dealing. The CitiStat system was also set up to map 3-1-1 calls about illegal dumping, blight, street maintenance, flooding, and trash pickup.

CitiStat was also used to monitor data on employee performance. Ultimately it reduced chronic absenteeism and tardiness and overtime spending, which led to cuts of more than $1 million from the budget in five months. The city also used performance measurement tools such as GIS to analyze response times by the fire department and ambulance services, which resulted in the closure of several fire companies, a necessary cost-cutting measure during a recessionary period.

The use of GIS in performance measurement and management systems quickly spread throughout Baltimore city government after O’Malley became mayor, but the Stat program started in the police department. There were two reasons for that.

First, the homicide rate in the mid-1990s in Baltimore was high. More than 300 people were killed each year. “When I ran for mayor of Baltimore in 1999, our city had become the most violent, addicted, and abandoned city in America,” O’Malley said. He was elected on his promise to turn things around.

Second, Maple—the “father” of the NYPD’s CompStat system—was laser focused on and well versed in crime mapping despite the fact he was fighting cancer at the same time.

“Even though he was suffering from a terminal diagnosis for colon cancer,” said O’Malley, “he agreed to come help me as our consultant to not only put police reforms in place and make our city safer but to take that same approach of the common platform—the data, the method, and the map—and do it enterprise-wide.”

Though elated about his election, the new mayor knew he had big problems to deal with. One of the first things O’Malley
and Maple tackled was to rid the city of the open-air drug markets that fomented much of the violence. CompStat maps showed all hot spots for crime in relation to the location of the open-air drug markets. This helped police officials, city leaders, and community activists decide which markets to target and close first.

Next, the City of Baltimore created the CitiStat system and meeting room, with computer screens on the wall for displaying relevant graphs and maps. There, O’Malley would meet with staff and tackle issues facing Baltimore in the early 2000s. Citizen complaints—such as graffiti sprayed on walls or trash dumped in an alley—coming in on the 3-1-1 system were mapped, too. Every two weeks, staff met to go over progress on these types of issues and view maps or graphs with data that O’Malley called “the latest emerging truth.”

Information that had sat in silos in one department now appeared on maps with information from other departments. In that way, O’Malley and his team could begin to see patterns that would help them make smarter decisions.

“Everybody had to open their data and land the individual silos of information on the map,” O’Malley said. “It all became mapped, and that map became a living, breathing thing.”

**Mapping the Big Picture**

Shortly after O’Malley became governor of Maryland, he met Esri president Jack Dangermond for the first time. He said Dangermond gave him a demonstration using empty coffee cups spread across a table to represent different silos of information from various departments.

“Jack said, ‘You’ve already figured out something that most elected leaders haven’t—you’ve realized that the map and GIS are a common powerful platform to combine those separate silos of information that everybody in government bemoans. If you land the base of all these efforts—all these separate silos of information—on the same map, then the map creates a picture, and then you can start running plays.’”

O’Malley did just that. Starting in 2007, he instituted StateStat to measure almost every facet of government performance including that of the Maryland State Police and the departments of Health and Mental Hygiene; Juvenile Services; General Services; Labor, Licensing, and Regulation; Housing and Community Development; Business and Economic Development; Veterans Affairs; and the State Highway Department. BayStat was launched to monitor progress toward cleaning up pollution and restoring the oyster population in Chesapeake Bay, and DrugStat was started to measure the performance of drug treatment programs in Baltimore. Many of these systems relied on maps to gauge what was happening.

StateStat measured progress on 16 goals that included addressing childhood hunger, infant mortality, substance abuse, preventable hospitalizations, violent crime, and energy efficiency. Underpinning the performance measurement and management systems were the maps produced using ArcGIS. Dashboards, some of which included maps Esri helped create, were published online, showing if progress was being made. Transparency is critical to achieving good results, according to O’Malley.

**A New Way of Governing**

In Smarter Government: How to Govern for Results in the Information Age, published by Esri Press, O’Malley lays out his philosophy in full. He outlines his approach to leadership and governance as one that’s long on collaboration, transparency, accountability, and data-driven decision-making with help from supporting technologies like GIS.

The book is geared toward current and aspiring government leaders and others who work in public service. Though it mainly focuses on how to be an effective leader and achieve results using data-driven performance management and predictive analytics systems, readers also will find links to 35 online GIS exercises or tutorials.

“I see a new way of governing emerging all across our country and the world,” he said. “It’s rising up from smart cities where men and women who lead these cities have figured out that the new default setting is not to hold information but to make [it] open and transparent and clear and visible—to create dashboards not only for your internal use but [ones] that every citizen can see whether we are making progress or not.”

As governor, O’Malley instituted StateStat to measure almost every facet of government performance in Maryland.
O’Malley sees his book as unique among books written about leadership, management, and technology because in it he shows how he combined collaborative leadership techniques with the use of the Stat to achieve desired results, whether it was to shut open-air drug markets or reduce lead poisoning cases among children.

This is O’Malley’s first book. It comes after a long political career, including roles as a city council member in Baltimore, the mayor of Baltimore, the governor of Maryland, and a candidate for president of the United States.

O’Malley said, “We have better technology than a self-governing people have ever had in the history of the planet to measure, model, and map not only our built and natural environment but the human dynamic that unfolds across it and to be able to do it in ways that all can see. Those are relatively new tools. What we need, as fast as the technology has advanced, [is to] catch up with the sociotechnical habits of leadership and management and collaboration that allow us to deliver real, tangible things—safer neighborhoods, cleaner water, better schools.”

About the Author
Carla Wheeler is a technology writer and editor at Esri and a former journalist. She graduated from the University of Minnesota with a bachelor’s degree in journalism and political science. She edits ArcWatch. Follow her on Twitter @gisjourno.
Teach Demographics with Web GIS

By Joseph Kerski

There’s a wealth of demographic data from around the world available to be studied and mapped by anyone who has access to ArcGIS Online and ArcGIS Living Atlas of the World.

With cloud-based tools and content, ArcGIS Online and ArcGIS Living Atlas of the World make it easy to analyze spatial demographic data. For students using this kind of technology, learning about demographics and population change can be interesting, engaging, and informative. Students can solve problems, think critically, and strengthen their reasoning and spatial analysis skills in multidisciplinary environments.

Over one billion maps are served via the ArcGIS platform. In addition to maps, the platform provides access to analysis, classification, symbology, and measurement tools; field apps; web mapping applications; and data that is shared by a community of users.

Web GIS is a practical way to teach students about demographic change. Changes in population patterns over space and time can be revealed by 2D and 3D GIS maps. Maps and applications can be saved, shared, and embedded into presentations and multimedia in a collaborative learning environment. With just a standard web-based browser, analytic and cartographic tools can be used on any device at any time. The open data movement places an array of rich, varied demographic datasets—in scales ranging from the local to global—in the hands of educators and students. This includes data from the US Census Bureau and other national statistics agencies.

Here are just six of the many ways you can use ArcGIS Online and the ArcGIS Living Atlas of the World to study demographics:

1. Examine world population and demographic data by country.
2. Visualize and understand migration over space and time in 3D.
3. Examine demographic patterns in select cities.
4. Examine regional change by using satellite imagery.
6. Use satellite imagery to investigate local changes.

There’s a wealth of demographic data from around the world available to be studied and mapped by anyone who has access to ArcGIS Online and ArcGIS Living Atlas of the World.
1. Examine world population and demographic data by country.

The ArcGIS Living Atlas of the World is a curated and growing body of content covering a multitude of scales. Population growth, ethnicity, density, cities, and other themes can be quickly accessed, combined with other layers of data, queried, and used in presentations. Many of the layers contain data that goes back in time; others contain forecasted growth and demographics.

This World Demographics Analysis web map (https://bit.ly/36EM1pN) includes some Living Atlas content and opens the door to investigating population growth rates, life expectancy, birth rates, and other variables. Some of the variables can be analyzed over time by opening the table associated with the maps and using the time animation slider. For additional analyses, modify the map below by clicking on it and adding other layers from the Living Atlas or ArcGIS Online.

2. Visualize and understand migration over space and time in 3D.

The Esri Cool Maps gallery features this 2D and 3D map visualization (coolmaps.esri.com/#10) of incoming and outgoing migration, organized by country, for four different time periods. The map presents estimates of the number of international migrants by destination and origin. The map uses a dataset called Trends in International Migrant Stock from the United Nations Department of Economic and Social Affairs.

This dataset contains a time series of estimates and projections of the number of international migrants in 232 countries or areas for the years 1990, 2000, 2010, and 2013. You can compare one country’s change over time in terms of both numbers and the places where migrants travel to and from.

For example, you can visualize the increase in immigration from South Asia and East Asia to Australia, relative to that country’s traditional immigration patterns from western Europe. You can also see the jump in Australia’s absolute numbers of migrants.

You can use the same map to investigate immigration to the United Arab Emirates (UAE), which supports the infrastructure development there. The map also will help your students understand the continuing challenges faced by Somalia caused by emigration from that country.
Examine demographic patterns in select cities.

Urban Observatory (www.urbanobservatory.org) is a mapping and visualization app that enables you to compare conditions—including housing density, traffic, youth population, and open space—for more than 100 cities around the world.

The app is powerful and easy to use. Themes include Work (such as zoning), Movement (such as roads, transportation noise, airports, and traffic), People (such as population density and growth), Public (such as ParkScore scores and health resources), and Systems (such as current temperature and flood zones).

Click the Launch App button to compare the cities and themes of your choice. These cities will be displayed in three side-by-side interactive maps at the same scale. Because some variables are from real-time feeds, you can use Urban Observatory to teach students about commuting, time zones, and seasons.

Examine regional change by using satellite imagery.

Easily detect regional changes to the landscape using Esri mapping tools such as the Swipe tool in the Landsat Explorer app (landsatexplorer.esri.com) and the Landsat Lens web mapping application (https://bit.ly/39euWEV).

Using Landsat Lens (no login required), you can explore any region of the planet, in several different wavelength band combinations for five different time periods. Use this resource to study urban growth, deforestation, volcanic eruptions, glacial retreat, agricultural expansion, and other natural and human-caused changes to the earth. You can study issues such as the expansion of the Sahara Desert southward into the Sahel, the drying up of the Aral Sea, and the continuous activity at Kilauea volcano in Hawaii.
Investigate local changes using historical topographic maps.

With access to 75,000 historical maps, you can use US Geological Survey (USGS) Historical Topographic Map Explorer (livingatlas.arcgis.com/topoexplorer/index.html) to quickly examine changes in your own community and others across the United States. These maps, available at a variety of scales, cover a century of geographic history.

Use the Search box to find places. Transparency and timeline tools make the app easy to customize and use to investigate places. No login is required. Study how the area around your school or university has changed, and examine that growth in relation to growth in communities nearby or across the country. The web mapping application has been updated so you can easily save these maps as web maps in your ArcGIS Online account.

Use satellite imagery to investigate local changes.

The World Imagery Wayback app (https://bit.ly/2uifcSc) contains high-resolution global satellite imagery for the past year. The imagery is stored in ArcGIS Online. The app opens with an image of Las Vegas, Nevada, where change has occurred rapidly over a short time period. You can easily see the direction and magnitude of urban sprawl.

Use the app to examine changes in specific places such as coastal erosion in England, the construction of the Three Gorges Dam in China, and the results of wildfires in Australia and California. Investigate phenomenon such as urban sprawl, landslides, and volcanic activity. Even look at construction that may have occurred at your school or university.

You can use the app on its own or use it with ArcGIS Online by clicking the plus sign to the right of each image layer to save it. Add this imagery to ArcGIS Online maps, and combine it with other layers on population change, cultural features, ecoregions, and elevation.

About the Author

Joseph Kerski is a geographer, Esri education manager, and an enthusiastic advocate for all things mapping. He earned a Doctor of Philosophy (Ph.D.) in geography from the University of Colorado, Boulder. Follow @josephkerski.
The Royal Botanic Gardens, Kew, more commonly known as Kew Gardens, uses GIS to fulfill its stated mission “to unlock the potential of plants and fungi, through the power of scientific discovery and research.” The facility supports conservation, research, and education programs.

Although its origins can be traced to the merging of the royal estates of Richmond and Kew in 1772, Kew Gardens was formally founded in 1840. Located in southwest London, Kew Gardens maintains the largest and most diverse botanical and mycological collections in the world. Its living collections include more than 27,000 taxa. It houses more than 8.5 million preserved plant and fungal specimens. Kew Gardens also is a repository for research materials, with a library containing more than 750,000 volumes and a collection of more than 175,000 prints and drawings of plants.

Since 1750, 571 species of vascular plants have become extinct. Vascular plants are characterized by specialized tissues for the internal transport of water and nutrients. The number of extinct species was determined through an extensive examination of peer-reviewed scientific publications by Rafaeıl Govaerts, a botanist at Kew Gardens. For the past 30 years, Govaerts has rigorously reviewed all known books on plant extinctions. “The real figure is undoubtedly higher, and a continued effort is under way to assess the threat status of each plant species,” said Govaerts.

**Sustainable Management and Protection**

Among its conservation programs, Kew Gardens initiated the Tropical Important Plant Areas (TIPA) project. The first phase of this project includes delimitation and mapping of concentrations of threatened plants in Bolivia, the British Virgin Islands,

![This world map shows the locations of countries participating in the first phase of the TIPA project: Bolivia, the British Virgin Islands, Cameroon, Guinea, Indonesian New Guinea, Mozambique, and Uganda.](image)
Cameroon, Guinea, Indonesian New Guinea, Mozambique, and Uganda.

The TIPAs project uses a revised Important Plant Areas (IPA) methodology that was developed in 1989 by Plantlife, the British wildlife charity. This methodology is used to assess plant conservation priorities at both the regional and national levels. Priorities are based on research, surveys, and expert knowledge. The TIPA designation is reserved for an area sustaining a threatened species or habitats, or one of botanical richness that includes useful plant species. The goal is to promote sustainable management and protection of TIPAs through engagement with policy makers, landowners, and international initiatives.

“We have used ArcGIS Online for the TIPA project since we began it in 2015,” said Jenny Williams, a senior spatial analyst at the Royal Botanic Gardens, Kew. “It is used by botanical experts to inform decisions critical to TIPA designation, and especially in relation to imminent threats to the flora from agricultural expansion, mining, illegal logging, wildfires, and dams.” A portal for TIPAs that will link to ArcGIS Online maps is currently under development.

“Our work is in developing countries that have limited access to current IT technology. Often, their computers are old, and the internet speeds are slow. In addition, they have little knowledge of GIS concepts, so I set up a framework that they can use to document their findings,” said Williams.

She provides these countries with a digital map of satellite imagery so local experts can digitize the location of endangered plant species and other key habitat areas on the map. A botanist will then analyze those maps to determine if endemic species are present in the indicated areas and if they are at risk and should be protected. Conversely, botanists also determine if an area has been cultivated for agriculture or degraded in other ways. There is little point in trying to protect these areas.

Regional groups meet with key staff in workshops to determine which areas to protect and the best way to do that. The findings from these workshops are presented to the government to implement procedures to protect critical habitats. The maps have also been used to guide collaborative fieldwork efforts, which sometimes result in the discovery of new species.

Williams is trying to get the TIPA proposed protected areas added to the ArcGIS Living Atlas of the World. ArcGIS Online lets Kew staff members easily distribute their findings and analyses through internet browsers. They also use ArcGIS Pro, ArcGIS Image Analyst, ArcGIS Spatial Analyst, Survey123 for ArcGIS, and Collector for ArcGIS to collect and analyze data. To collect imagery, they use the Landsat time series, Sentinel, and WorldView 2.

“The Landsat time series lets us analyze the land by season, allowing us to distinguish, for example, between submontane forests [located near the base of a range of mountains] and lowland forests,” said Williams.

Increasing Research Opportunities

Though the Kew Gardens collection of plant life represents more than 95 percent of the known flowering plant genera and over 60 percent of known fungal genera, only 20 percent of the data in this collection is currently available online. To make its digital resources more widely available, the Plants of the World Online (POWO) portal was launched in 2017. Kew Gardens is committed to POWO and other similar initiatives that serve to maximize its impact on science, education, conservation policy, and resource management.

“We are creating POWO as a single point of contact for authoritative plant species information,” said Williams. “Data from POWO will feed directly into conservation prioritization for the delivery of on-the-ground conservation actions by our partners.”

Kew Gardens staff would like to add a drone with lidar and hyperspectral sensors to its technology stack to access 300 to 400 spectral bands. This would allow them to mirror the signature of the plants on the ground to enhance plant identification.

“We hope to introduce ArcGIS Hub in the future, which will give us greater opportunities to share our work with both our in-country partners, as well as our colleagues around the world,” concluded Williams.

About the Author

Jim Baumann is a longtime employee at Esri. He has written articles on GIS technology and the computer graphics industry for more than 30 years.
A graduate certificate that aligns with geospatial workforce needs

In response to the ever-increasing changes in the Geographic Information Systems (GIS) business world, the University of Redlands now offers an online GIS graduate certificate program starting in fall 2020.

- Self-paced online program
- Classes designed and taught by full-time faculty and experienced adjunct faculty from Esri
- Access extensive Esri resources
- Earn graduate-level credits applicable toward a master of science in GIS or a master of GIS
- Expand your professional network

Learn more

gis.redlands.edu

“The University of Redlands is a private, nonprofit university located in Redlands, California—close neighbors and partners with geospatial leader, Esri.”

—Blythe Spendlove, MS GIS ’18
Business Systems Analyst, Southern California Gas Company
THANK YOU TO THE GIS COMMUNITY.
Your data, science, and mapping are helping to defeat an invisible enemy and save lives.

See how GIS professionals from around the world are responding to COVID-19 at esri.com.